
 

  

 





 

Contents 

Chapter 1. An Introduction to RealFlight® G2 Lite 1 

Introduction ............................................................................................................................... 1 
What's New in RealFlight Lite with USB InterLink™ controller.............................................. 1 

USB InterLink Controller ............................................................................................ 1 
Menu-Driven Interface ................................................................................................ 2 
Additional Features ..................................................................................................... 2 

Chapter 2.  Before You Begin 3 

System Requirements ................................................................................................................ 3 
Video and Sound Cards ............................................................................................................. 4 
Getting the Most out of RealFlight G2 Lite ............................................................................... 4 

Chapter 3.  Getting Started 5 

Overview ................................................................................................................................... 5 
Installing RealFlight G2 Lite ..................................................................................................... 5 

Program Installation .................................................................................................... 6 
Using Your Own R/C Radio to Control RealFlight (Optional) ................................... 8 

Exploring RealFlight G2 Lite .................................................................................................... 9 
Start the Program ......................................................................................................... 9 
The RealFlight G2 Lite Main Display ....................................................................... 10 
Choosing Your Aircraft ............................................................................................. 12 
Changing Airport ....................................................................................................... 14 
Some Common Tasks ................................................................................................ 16 
The Binocular View .................................................................................................. 16 
Using Gadgets ........................................................................................................... 17 
Virtual Flight Instructor™ ......................................................................................... 17 

Where to Go from Here ........................................................................................................... 18 

Chapter 4. Using RealFlight G2 Lite 21 

Introduction ............................................................................................................................. 21 
Program Features ..................................................................................................................... 21 
Controller Features .................................................................................................................. 24 
Graphics and Sound Quality .................................................................................................... 24 
Technical Support .................................................................................................................... 25 

Chapter 5. The InterLink Controller 26 

The InterLink Controller—Designed for R/C .......................................................................... 26 
Start Flying! ............................................................................................................................. 27 
Joystick vs. Interface Mode ..................................................................................................... 27 
The InterLink Controller (Joystick Mode) ............................................................................... 28 
The InterLink Controller (Interface Mode) .............................................................................. 29 

Interface Mode Features and Terminology ................................................................ 29 



 

Interface Mode: Joystick Emulation Interface ......................................................................... 30 
Calibration vs. Interface Wizard ................................................................................ 30 
Interface Calibration .................................................................................................. 31 
Interface Wizard ........................................................................................................ 31 

InterLink Controller Hints and Tips ......................................................................................... 32 
What if my transmitter has fewer than eight channels? ............................................. 32 

Chapter 6.  The Airport Menu 35 

Airport Menu Overview ........................................................................................................... 35 
Select Airport… ....................................................................................................................... 36 
Item Visibility .......................................................................................................................... 36 
Show Trees .............................................................................................................................. 37 
Show Fog ................................................................................................................................. 37 
3D Terrain ................................................................................................................................ 37 
Weather Conditions ................................................................................................................. 37 
Exit ........................................................................................................................................... 39 
Airport MRU............................................................................................................................ 39 

Chapter 7.  The Aircraft Menu 41 

Aircraft Menu Overview .......................................................................................................... 41 
Aircraft Smoke ......................................................................................................................... 43 
Show Exhaust .......................................................................................................................... 43 
Reset Position .......................................................................................................................... 43 
Kill Engine ............................................................................................................................... 43 
Aircraft MRU ........................................................................................................................... 43 

Chapter 8.  The Options Menu 45 

Options Menu Overview .......................................................................................................... 45 
Direct3D .................................................................................................................................. 46 
Controller Calibration .............................................................................................................. 48 
Graphics Optimizations ........................................................................................................... 51 
Miscellaneous .......................................................................................................................... 52 
Run in Window ........................................................................................................................ 54 
Enable Collisions ..................................................................................................................... 54 
Virtual Flight Instructor™ ....................................................................................................... 54 
Music/Sound ............................................................................................................................ 55 

Chapter 9.  The View Menu 59 

View Menu Overview .............................................................................................................. 59 
Binocular View ........................................................................................................................ 60 
Zoom Reset .............................................................................................................................. 60 
Zoom In ................................................................................................................................... 60 
Zoom Out ................................................................................................................................. 60 
Pilot At Fixed Position ............................................................................................................. 61 

Set To Pit Area .......................................................................................................... 61 
Set to Current Aircraft Position ................................................................................. 61 
Set with Overhead View ............................................................................................ 61 
Set to Last Fixed Position .......................................................................................... 61 
Set with Mouse .......................................................................................................... 62 
Set Current Position as Pit Area ................................................................................ 62 
Named Positions ........................................................................................................ 62 

Pilot in Aircraft ........................................................................................................................ 62 
Pilot Behind Aircraft ................................................................................................................ 63 



 

Look at My Aircraft ................................................................................................................. 63 
Look at Wind Sock .................................................................................................................. 63 
Look at Ground ........................................................................................................................ 63 
Look at Location ...................................................................................................................... 63 
Quick Look .............................................................................................................................. 63 
Gadget ...................................................................................................................................... 63 

NavGuides™ Gadget ................................................................................................. 64 
Flight Playback Gadget (Only Available With the Virtual Flight Instructor) ........... 64 
Radio Gadget (Only Available With the Virtual Flight Instructor) ........................... 65 

Pilot and Viewport Options ..................................................................................................... 65 
Viewport Page ........................................................................................................... 65 

Chapter 10.  The Help Menu 69 

Help Menu Overview .............................................................................................................. 69 
Contents ................................................................................................................................... 70 
Technical Support .................................................................................................................... 70 
Credits ...................................................................................................................................... 70 
Slide Show ............................................................................................................................... 70 
Tip of the Day .......................................................................................................................... 70 
Online Updates ........................................................................................................................ 71 
Screen Shot .............................................................................................................................. 71 

Appendix A. Flying the Aircraft 73 

Airplane Basics ........................................................................................................................ 73 
Switches .................................................................................................................... 73 
Centering ................................................................................................................... 73 

Crashing ................................................................................................................................... 73 
Airplane Flight ......................................................................................................................... 74 

Takeoffs ..................................................................................................................... 74 
Landings .................................................................................................................... 74 
Aerobatics .................................................................................................................. 75 
Throttle Management ................................................................................................ 75 
Rudder Management ................................................................................................. 75 
Take Crashes Seriously ............................................................................................. 75 

Helicopter Basics ..................................................................................................................... 76 
Collective (left stick - vertical movement) ................................................................ 76 
Rudder (left stick - horizontal movement) ................................................................. 77 
Cyclic Stick (right stick) ............................................................................................ 78 
Idle-up ....................................................................................................................... 80 
Throttle Hold ............................................................................................................. 80 
Gyro ........................................................................................................................... 80 

Helicopter Flight ...................................................................................................................... 80 
Hovering .................................................................................................................... 80 
Forward Flight ........................................................................................................... 80 
Backward Flight ........................................................................................................ 80 
Sideways Flight ......................................................................................................... 81 
Turning: ..................................................................................................................... 81 

Appendix B. RealFlight G2 Lite Control Panel 83 

RealFlight G2 Lite Control Panel ............................................................................................ 83 
Running the Control Panel ........................................................................................ 84 
Running RealFlight Lite ............................................................................................ 84 
Uninstalling RealFlight Lite ...................................................................................... 84 
Read Help File ........................................................................................................... 85 



 

Technical Support ...................................................................................................... 85 
Viewing Documents .................................................................................................. 90 

Online Updates ........................................................................................................................ 90 
Registration ................................................................................................................ 90 
Updating to the Latest Version .................................................................................. 91 
Advanced Options ..................................................................................................... 92 
Problems Updating? .................................................................................................. 93 

Appendix C. If You Experience Difficulties With RealFlight G2 Lite… 95 

In General ................................................................................................................................ 95 
How to Get Help and Information ............................................................................. 95 
Before You Do Anything Else… ............................................................................... 96 
If You Need additional assistance… ......................................................................... 98 

Examples of Common Problems and Solutions ....................................................................... 98 
If You Don’t See Your Problem in This Chapter… .................................................. 98 
My computer “freezes” when I run RealFlight G2 Lite, and I need to reboot to regain 
control. ....................................................................................................................... 99 
Improving RealFlight® Lite Performance ................................................................. 99 
Other Common Problems ........................................................................................ 100 

Glossary of Terms 101 

Index 111 

 



R/C Simulator RealFlight Chapter 1. An Introduction to RealFlight® G2 Lite    1 

  CCHHAAPPTTEERR  11..  AANN  IINNTTRROODDUUCCTTIIOONN  TTOO  

RREEAALLFFLLIIGGHHTT®®  GG22  LLIITTEE  

IINNTTRROODDUUCCTTIIOONN  
Welcome to the RealFlight Generation 2 Lite R/C Simulator.  RealFlight G2 Lite is 
so realistic, you’ll hardly believe it’s a simulation.  Whether you’re a seasoned 
modeling veteran, or an entry-level R/C-er, RealFlight G2 Lite is the ideal way to 
learn to fly, practice maneuvers, or just have an incredible amount of fun.  

RealFlight G2 Lite offers an amazing array of tools to help you understand how to 
use the program, and how to improve your R/C piloting skills. From extensive 
tooltips that explain every feature and option as you use it, to our Virtual Flight 
Instructor™ feature, to the extensive manual and technical support, no other R/C 
simulator goes further to enrich your R/C experience. 

The following section briefly outlines some of the new features in RealFlight G2 
Lite.  

 

WWHHAATT''SS  NNEEWW  IINN  RREEAALLFFLLIIGGHHTT  LLIITTEE  WWIITTHH  UUSSBB  

IINNTTEERRLLIINNKK™™  CCOONNTTRROOLLLLEERR  
This section briefly outlines some of the features included in RealFlight G2 Lite with 
the USB InterLink controller.  RealFlight G2 Lite and the InterLink Controller 
incorporate a significant number of enhancements and improvements over the 
previous RealFlight systems.  If you are new to RealFlight, or just don’t want to read 
this section, you can proceed to the next chapter. Subsequent chapters will cover this 
material in complete detail. 

USB INTERLINK CONTROLLER  
All RealFlight versions now come equipped with Great Planes®’s USB InterLink 
Controller by Futaba®. This revolutionary device brings you: 
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 A high quality, USB compatible, plug and play controller for 
RealFlight G2 Lite. 

 A built-in interface for (optionally) using your own R/C transmitter for 
controlling RealFlight G2 Lite (should you so desire). 

 The InterLink Controller is fully hot pluggable—you can 
connect/disconnect the InterLink, or your own transmitter, without 
rebooting your computer (or even shutting down RealFlight G2 Lite). 

 Higher speed response to control inputs. 

 Digitally precise inputs for unmatched control precision. 

MENU-DRIVEN INTERFACE  
Upon starting G2 Lite, the first thing that you are likely to notice is the user 
interface. RealFlight G2 Lite runs in a window (assuming your video card supports 
this option), and the interface is completely menu-driven. If, however, you like the 
full-screen look, you can recover this in G2 Lite by removing the check mark from 
the Run in Window item in the Options menu. (In full-screen mode, press “ALT” 
or “ESC” to access the RealFlight Lite menus.) 

ADDITIONAL FEATURES 

 Incredibly realistic airplane and scenery graphics, using detailed, 24-bit 
textures. 

 RealFlight G2 Lite’s Virtual Flight Instructor™ feature gives you 
personal flying lessons from two R/C experts.  These pros will help you 
learn and perfect maneuvers. 

 On-screen Gadgets let you view continuously updated aircraft data, 
with a simple click of the mouse.  

 Full collision detection. If you hit a building, your aircraft crashes.  

 Aircraft have visible exhaust. 

 All aircraft feature moving control surfaces and retracts that visibly 
move (if applicable). 

 G2 Lite’s Control Panel allows for easy, one-click updating and 
simplified technical support should the need arise. 

We hope you enjoy these, as well as the various other features in G2 Lite. Keeping 
the “Tip of the Day” feature active serves as a great reminder about these new 
features.  

And please, keep the suggestions coming!  Great Planes and Knife Edge Software 
are continually enhancing RealFlight G2 Lite, striving to provide you with the most 
accurate R/C simulator ever created.  
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    CCHHAAPPTTEERR  22..    BBEEFFOORREE  YYOOUU  BBEEGGIINN  

SSYYSSTTEEMM  RREEQQUUIIRREEMMEENNTTSS    
The system requirements below are what we consider to be the minimum PC 
configuration in which RealFlight G2 Lite should be installed. Meeting the minimum 
requirements will allow you to still enjoy the simulator; however, in order to take 
complete advantage of the many features and functions offered by RealFlight G2 
Lite, you should have a computer at, or above, the specifications as listed under the 
optimum system requirements. 

MINIMUM SYSTEM REQUIREMENTS 

 Windows® XP*, 2000*, ME or 98  

* Local administrator access required for Windows® XP or 2000 

 Intel® Pentium® 300 or equivalent processor 

 64 MB RAM 

 DirectX™ 8.1 (or above) compatible video card with at least 8MB of 
RAM (Note that Voodoo I and Voodoo II cards are not supported 
because they do not allow you to run in a window or view a menu 
while full screen) 

 DirectX™ 8.1 (or above) compatible sound card 

 500 MB hard drive space 

 4x CD-ROM drive 

 Super VGA monitor 

 USB port 

 

 

SUGGESTIONS FOR OPTIMUM PERFORMANCE 

In addition to the requirements above: 

 Intel® Pentium® III 600 (or equivalent) or higher processor 
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 Microsoft Direct 3D compatible high performance 3D accelerated 
video card with 16 MB (or more) video RAM 

 16x CD-ROM drive 

 128 MB RAM 

 

VVIIDDEEOO  AANNDD  SSOOUUNNDD  CCAARRDDSS  
In order to achieve optimum performance and the ultimate satisfaction from 
RealFlight G2 Lite, there are two important components of your computer that 
deserve special attention: the video and sound cards. 

While RealFlight G2 Lite will work well on a wide variety of hardware 
configurations, it offers many features that are designed to take particular advantage 
of the latest video technology. If you have an older computer, or a newer computer 
with a lower-end video card, you may want to consider purchasing a new video card 
to take advantage of these features. This moderately priced upgrade can vastly 
enhance your enjoyment of RealFlight G2 Lite. Aside from increasing your 
satisfaction with G2 Lite, a new video card will also work with many other games, 
simulators, or other such applications, improving their performance as well. 

While not as important as a video card, upgrading your sound card may also improve 
your satisfaction with RealFlight G2 Lite.  This is especially true if your computer 
uses an on-board sound card (that is, a sound card affixed to the motherboard.) 

 

GGEETTTTIINNGG  TTHHEE  MMOOSSTT  OOUUTT  OOFF  RREEAALLFFLLIIGGHHTT  GG22  LLIITTEE  
 

Great Planes and Knife Edge Software are committed to the continual improvement 
of our products. When using the software, there are two things you should keep in 
mind. 

First of all, similar to other pursuits, what you get out of RealFlight G2 Lite depends 
upon what you put in. Mastering radio control requires a great deal of patience and 
practice. If you crash an aircraft in the simulation, take it very seriously. Crashing an 
actual R/C aircraft can cost you a lot of time and money. Try to examine what you 
did incorrectly, using the experience to avoid making the same mistake again.   

Secondly, while the simulator is quite realistic and will assist you in learning many 
of the skills necessary to become a proficient pilot, there is no substitution for actual 
stick time.  No simulator, no matter how realistic, can completely replace a qualified, 
experienced, human flight instructor. A simulation can be a wonderful practice tool. 
However, if you’re new to R/C, you should never attempt to fly a real aircraft 
without the supervision of a qualified instructor, no matter how well accomplished 
you are on the simulator.  
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  CCHHAAPPTTEERR  33..    GGEETTTTIINNGG  SSTTAARRTTEEDD  

OOVVEERRVVIIEEWW  
This chapter covers the installation procedure for RealFlight G2 Lite, describes the 
basics in running the program, and will introduce you to some of RealFlight G2 
Lite’s most often used features. 

The first section, Installing RealFlight G2 Lite, offers a step-by-step approach to the 
installation procedure for both the program software and the controller. 

The second section, Exploring RealFlight G2 Lite, offers a brief tour of the 
RealFlight G2 Lite program.  You'll learn how to perform some basic functions, such 
as selecting the aircraft you wish to fly, performing simple edits to the flying field, 
and using RealFlight G2 Lite’s Virtual Flight Instructor™ feature. 

This chapter only touches on some of RealFlight G2 Lite’s features.  While reading 
the chapter is enough to get you acclimated to the program, you’ll more than likely 
want to refer to subsequent chapters, which describe the various features in 
comprehensive detail. 

 

IINNSSTTAALLLLIINNGG  RREEAALLFFLLIIGGHHTT  GG22  LLIITTEE  
 

RealFlight G2 Lite comes equipped with Great Planes’s RealFlight USB InterLink 
Controller by Futaba. The InterLink has two modes. By itself, it serves as a realistic 
“standalone” controller for RealFlight G2 Lite. Alternatively, it has a built-in 
interface that lets you use your own R/C transmitter to control RealFlight G2 Lite. 
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The USB InterLink controller 

To install RealFlight G2 Lite using the InterLink Controller, follow the instructions 
in this chapter.  

Whether you plan to use the InterLink Controller by itself, or with your own R/C 
radio to control RealFlight G2 Lite, you should first follow the instructions in 
“Program Installation” on page 6.  

If you will be using your own R/C transmitter to control RealFlight G2 Lite (using 
the InterLink controller’s built-in adapter), follow the installation instructions in 
“Using Your Own R/C Radio to Control RealFlight (Optional) ” on page 8. If you 
do not plan on using your own R/C radio to control RealFlight G2 Lite, you can skip 
that section. 

PROGRAM INSTALLATION 
This section will explain how to install the RealFlight G2 Lite program and the 
RealFlight USB InterLink Controller. When you finish this section, you should be 
able to fly aircraft, using the InterLink to control aircraft. 

The InterLink’s built-in transmitter interface also allows you to use your own R/C 
transmitter to control RealFlight G2 Lite. To do this, you will first need to follow the 
instructions in this section. Then, follow the directions in the section entitled “Using 
Your Own R/C Radio to Control RealFlight (Optional) ” on page 8.  

UPDATE DRIVERS 

Before you begin installation, we strongly suggest that you update the drivers for 
both the sound and video cards.  A driver is a software program that your computer 
uses to control hardware devices. Each card has its own respective driver. Most 
problems with installing and using RealFlight G2 Lite, as well as many other 
programs that use DirectX, arise from outdated video and/or sound card drivers. 

If you’re not sure how to update your drivers, you can find instructions in article 
Q01-1038, How to Update Drivers, at http://www.gpsoftware.com/kb/q01-1038.htm. 
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That article will take you through the process step-by-step, and has links to driver 
download sites for most manufacturers. 

START INSTALLATION PROGRAM 

Once you’ve installed the new drivers, you’re ready to install RealFlight G2 Lite. 
First, turn your computer “on” and close any applications you are running. Next, 
insert the RealFlight G2 Lite CD-ROM into the CD-ROM drive.  If auto-play is 
active, the RealFlight G2 Lite Control Panel will appear.  Click the Install 
RealFlight G2 Lite CD button located at the top of the Control Panel to begin the 
installation process.  

If auto-play is not active, you will need to locate and run the program “SETUP.EXE” 
from the root directory of the CD-ROM.  To do this, click the Start button on the 
Windows® Taskbar, then select Run from the Start menu. In the Run window, type 
“d:\setup” and press [Enter] or click OK (assuming “d:\” is the designation for the 
CD-ROM drive). This should start the setup program. 

RUN INSTALLATION PROGRAM 

Follow the onscreen instructions, filling in information when queried by the setup 
program.  When the setup program asks for your program serial number, use the 
RealFlight G2 Lite serial number as it appears on the rear side of the CD-ROM jewel 
case. When it asks for the Interlink™ serial number, use the serial number located on 
the rear side of the InterLink controller.  These numbers must be entered exactly as 
they appear in order to proceed to the next phase of the installation process. When 
entering the serial numbers, please make sure that you include all dashes, letters, etc. 
as found on the product serial numbers.  Failure to enter the serial numbers correctly 
will not allow you to proceed to the next step.   

INSTALL DIRECTX 

After the program has finished copying the necessary files, it will ask you if you 
want to install DirectX.  If you do not meet the minimum DirectX version 
requirement as queried by the RealFlight G2 Lite program, click Yes to install this 
updated version of DirectX.  It will not harm your computer to install DirectX more 
than once.  Therefore, if you are unsure as to the status of this program we suggest 
that you install it at this time.  When DirectX has been installed, click Finish to 
complete the Setup. 

CONNECT THE INTERLINK CONTROLLER 

Finally, plug the RealFlight Lite InterLink controller into a USB port on your 
computer (see diagram). On most computers, the USB ports are clearly labeled. 
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Please note, the InterLink controller is hot pluggable or hot swappable. In other 
words, you can normally plug/unplug the controller without turning your computer 
“off” or rebooting. 

While your InterLink Controller is plugged in, and your computer is turned “on”, 
you should see a small amber light on your controller flash “on” and “off”. This 
light, labeled “USB”, indicates that the InterLink controller is connected and 
working. 

RUN REALFLIGHT G2 LITE 

To complete the installation and start the program, click on the RealFlight G2 Lite 
icon located on the desktop.  RealFlight G2 Lite will guide you through the final 
installation steps, as well as the calibration of your controller. 

You are now set up to run RealFlight G2 Lite, using the InterLink as a dummy 
transmitter. If you would like to use your own R/C transmitter as a controller, please 
read the following section, “Using Your Own R/C Radio to Control RealFlight 
(Optional)”. If not, you’re ready to start using RealFlight. Proceed to “Exploring 
RealFlight G2 Lite” on page 9, which will walk you through the basics of using the 
RealFlight G2 Lite program. 

USING YOUR OWN R/C RADIO TO CONTROL REALFLIGHT 

(OPTIONAL)  
Follow these instructions if you intend to use your own R/C transmitter to control 
RealFlight G2 Lite. If you don’t want to use your own transmitter, skip this section. 
Before reading this section, you should first follow the instructions in “Program 
Installation” on page 6.  

CONNECT YOUR TRANSMITTER 

You can use your R/C transmitter to control RealFlight G2 Lite by connecting it to 
the InterLink controller, “buddy box” style (see diagrams). RealFlight G2 Lite 
includes a cable and adapter for making this connection to many popular R/C 
transmitters. 
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First, locate the cable input port on the rear of the InterLink Controller. Plug one end 
of the included connector cable into this port. Next, the other end of the adapter cable 
must be plugged into the buddy box port (a.k.a. trainer jack) of your transmitter. The 
procedure for doing so depends on your transmitter: 

 If your transmitter’s buddy box port directly accepts the 1/8” stereo 
plug on the other end of the connector cable, plug this in. This works 
for JR® radios.  

 If your radio takes a 6-pin DIN plug (like Futaba radios), use the short 
extra 1/8” stereo to 6-pin DIN adapter cable included with RealFlight 
G2 Lite (see left panel of the diagram above). 

 Some radios (e.g., Airtronics®) require an optional adapter cable, 
which is not included with RealFlight G2Lite.  This optional adapter 
cable is available wherever you purchased RealFlight G2 Lite. 

SETUP 

After you have connected your transmitter, you will need to perform a setup 
procedure before you can proceed. For more details, see “The InterLink Controller 
(Interface Mode)” on page 29. 

Once you have a controller set up (either the InterLink mockup controller or your 
own transmitter), you’re ready to start using RealFlight Lite. You can now proceed to 
“Exploring RealFlight G2 Lite” on page 9, which will walk you through the basics 
of using RealFlight G2 Lite. 

EEXXPPLLOORRIINNGG  RREEAALLFFLLIIGGHHTT  GG22  LLIITTEE    
Now that you’ve installed G2 Lite, it’s time to begin exploring the program. The 
following sections will take you on a quick tour of RealFlight G2 Lite’s most 
popular features, such as selecting an aircraft to fly, changing flying fields, using 
RealFlight Lite’s Virtual Flight Instructor™, etc. Along the way, we'll show you 
where to go for help, or how to obtain additional information. 

START THE PROGRAM 
After installation, you should see a RealFlight G2 Lite icon on your computer's 
desktop.  First, close all open programs and windows (RealFlight G2 Lite performs 
best when it is the only program running, i.e., not sharing resources with any other 
programs or applications.)  Next, start RealFlight G2 Lite by double-clicking the 
RealFlight G2 Lite icon. 



10    Chapter 3.  Getting Started R/C Simulator RealFlight 

Also, you will see a “Tip of the Day”. The Tip of the Day feature is a sequence of 
helpful tips, hints and facts about G2 Lite that will enhance your enjoyment of the 
program.  

 

Normally, you will see a new tip each time you start RealFlight G2 Lite. If you wish, 
you can deactivate this feature by removing the check mark from the “Show tips at 
startup” box. If you turn Tip of the Day “off”, you can turn it “on” again using 
RealFlight Lite’s Help menu. 

We suggest leaving Tip of the Day active until you are better acclimated with the 
software and all that it has to offer. The tips will point out many great RealFlight G2 
Lite features that you may not have noticed. For now, just click “OK” to close the 
Tip of the Day window and start flying. 

THE REALFLIGHT G2 LITE MAIN DISPLAY 
When you first run RealFlight G2 Lite, you should see a window like the one below 
(assuming your video card supports DirectX Window mode, most cards do).  

 

You can move, resize, minimize, maximize and restore the RealFlight G2 Lite main 
window just as you would any other application.  
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You interact with G2 Lite using the menus in the main window’s menu bar: 

 Airport 

 Aircraft 

 Options 

 View 

 Help 

If RealFlight G2 Lite has started, but you don’t see any window borders or menus, 
you may be running in full screen mode. “Full screen mode” means that the 
RealFlight G2 Lite main display will take up your entire monitor screen. If this is the 
case, you can access the menus by hitting your keyboard’s “ALT” key or, 
alternatively, the “ESC” key. For additional information about window mode and 
full screen mode, see “Run in Window” on page 54. 

Later in this manual, you’ll find a separate chapter for each menu. These later 
chapters will describe, in detail, every single menu item and option. For now, 
though, we want to show you two aspects of the RealFlight G2 Lite user interface: 

 How to navigate the menus and find out what the different commands 
do; and  

 How to perform some of the most common tasks-- selecting aircraft 
and flying field, etc. 

Menus, Tooltips, and Diagrams 

Menus allow you to access RealFlight G2 Lite commands. To open a menu, click on 
its title (e.g., Aircraft): 

 

Menu Tool TipsIf you ever want to know what a menu item does, hold the mouse 
cursor over the item for several seconds. You will see a yellow popup window 
(called a tooltip window) that explains the item’s function. For example, if you put 
the mouse cursor over the Show Exhaust… item in the Aircraft menu, this is what 
you would see:  
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Dialog Tool Tips 

Tooltips also work for RealFlight G2 Lite dialogs as well. If you see a RealFlight G2 
Lite dialog, and want to know what a control (button, checkbox, etc.) in that dialog 
does, simply place the mouse cursor over the item until a tooltip window appears. 
For example: 
 

When to use the Interface Wizard, and when to use the Software Radio or Servo 
page  

  

CHOOSING YOUR AIRCRAFT 
When you first start RealFlight G2 Lite, you will be flying a default aircraft. In the 
examples below, the default plane is a PT-40® trainer. 

To change your aircraft, choose the Select Aircraft… menu item in the Aircraft 
menu: 
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You will see a dialog that looks like this: 
 

 

Pick the aircraft you want from the list in the upper left corner of the dialog (under 
Aircraft Selection). For example, to fly a Jet Ranger, scroll the list to find the Jet 
Ranger, and select it by clicking on the listing. 

The list contains every plane and helicopter available to you. Whenever you select an 
aircraft, a picture of that aircraft appears in the preview panel to the right.  

This dialog will also allow you to select a skill level that will affect how responsive 
the aircraft is during flight.  Furthermore, the Beginner setting will graphically scale 
the aircraft to make it easier to see.  

After you have finished selecting a new aircraft and skill level, click “OK.” The 
Aircraft Selection dialog will disappear, and you will return to the RealFlight G2 
Lite main window, with your new aircraft loaded. 



14    Chapter 3.  Getting Started R/C Simulator RealFlight 

Most Recently Used Lists 

RealFlight G2 Lite has two Most Recently Used lists (MRUs).  These lists show you 
the recently used aircraft and airports.  The various MRUs operate similarly. To see 
the Aircraft MRU, open the Aircraft menu again, and look at the last two items: 

 

Your current aircraft (Jet Ranger) is now the next-to-last item in the menu, and your 
previous aircraft (the PT-40) is now the last item. If you want to return to flying the 
PT-40, you can use the Select Aircraft… item, or you can just select 2. PT-40 from 
the Aircraft menu. 

The Aircraft menu will list your four most recently used aircraft. To reload a 
previously flown aircraft, simply select it from the list. 

CHANGING AIRPORT 
To change airports, click on the Select Airport… item in the Airport menu. You 
will see the following dialog: 
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Select the airport you want from the list at the top of the box. For example, to switch 
from Black Rock to Rainbow Canyon: 

 Select Rainbow Canyon from the list; and 

 Click OK 

RealFlight G2 Lite will load the new airport. 

The Airport menu will display your most recently used airports, in the same way the 
Aircraft menu displayed the most recently used aircraft: 
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If you want to return to Black Rock, just select it from the list at the bottom of the 
menu. 

SOME COMMON TASKS 

 To reset your aircraft to its original takeoff position, select Reset 
Position under the Aircraft menu. Alternatively, you can also press 
your keyboard’s space bar.  

 To turn airplane smoke “on” or “off”, select Airplane Smoke from the 
Aircraft menu. Alternatively, you can hit your keyboard’s “`”(accent) 
key. 

 To zoom in on an aircraft, select Zoom in in the View menu. 
Alternatively, press your keyboard’s F2 key. Repeat to increase the 
zoom level further.  Use F3 to zoom back out; use F1 to reset to the 
default zoom level. 

 To set your viewpoint using the mouse, select Pilot in Fixed Position 
in the View menu. When a submenu appears, select Set with Mouse. 
Then, move your viewpoint towards or away from your aircraft by 
sliding the mouse forward or back. Circle around the aircraft by 
moving the mouse sideways. Move your viewpoint up or down using 
the mouse wheel. Alternatively, if you don’t have a mouse wheel, hold 
the right button down and slide the mouse forward or back. 

THE BINOCULAR VIEW 
The Binocular View option will show a perfectly zoomed aircraft.  You will see the 
aircraft as if you were looking through a pair of binoculars.  In Binocular View, the 
background of the viewport box becomes transparent.   This is a visual indicator so 
that you are aware that this viewport is using “binocular vision”. 

Binocular View is a great way to see the control surfaces on an aircraft that is too far 
away to see in the Main View.  Although not realistic, it does help to see the control 
input.   
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USING GADGETS 
The NavGuides™ Gadget displays continuously updated information about your 
aircraft’s altitude, distance above ground, speed, heading, etc. To display the 
NavGuides Gadget,  

 Open RealFlight G2 Lite’s View menu. 

 Select Gadget. 

 When a submenu appears, select NavGuides. 

When you select NavGuides, you should see the NavGuides Gadget appear on your 
screen:  

 

 

 

Like viewports, it is possible to: 

 close the gadget by clicking the red “X” on the gadget’s title tab; 

 move the gadget by dragging its title tab; 

 

VIRTUAL FLIGHT INSTRUCTOR™ 
RealFlight G2 Lite’s Virtual Flight Instructor provides you with private flying 
lessons from an industry professional.  

To start a lesson, select Virtual Flight Instructor located in the Options menu. 
When a dialog appears, select the lesson you want to view. 
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Click “OK”, and RealFlight G2 Lite does the rest. You will see the instructor’s 
aircraft fly the maneuver. You’ll hear the instructor’s voice, explaining how it’s 
done. You can watch the instructor’s actual stick movements using an onscreen, 
digitized R/C radio.  

You can even fly your own aircraft next to the instructor’s!  This allows you to 
mimic the inputs and aircraft reaction simultaneously. 

To watch the instructor fly, close the binocular view if it is open, prior to starting the 
lesson. Close a viewport by clicking the red “X” in the viewport title tab. The main 
window will show the instructor’s aircraft. The onscreen radio will show the 
instructor’s stick movements. 

If the instructor’s aircraft seems to disappear under or behind hills, buildings, etc., 
then the instructor “taped” the lesson at a different airport than the one you are flying 
at. Try changing to an airport with flat terrain and relatively few obstructions. We 
suggest “Rainbow Canyon” as it works well for this purpose.  

 

 

 

WWHHEERREE  TTOO  GGOO  FFRROOMM  HHEERREE  
 

The examples in this chapter only scratch the surface of RealFlight G2 Lite’s 
capabilities.  We encourage you to explore RealFlight G2 Lite using some of the 
methods below. 

 You may want to browse the menus, pausing the mouse cursor over 
each item to read the tooltips. This gives you a good overview of the 
RealFlight G2 Lite commands. 

 Keep the Tip of the Day feature active until you have read through all 
the tips at least once. Tip of the Day describes many features that you 
may have missed. 
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 If you’d like to learn more about a particular menu or item, look it up in 
this manual’s table of contents. 

 If you’d like RealFlight G2 Lite to do something, but can’t find an 
appropriate command, check this manual’s index.  

 Use the Help facilities in RealFlight G2 Lite’s Help menu. 

 Talk to other RealFlight G2 Lite users. When you visit 
http://www.knifeedge.com, check out our chat room and discussion 
board. 
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  CCHHAAPPTTEERR  44..  UUSSIINNGG  RREEAALLFFLLIIGGHHTT  GG22  

LLIITTEE  

IINNTTRROODDUUCCTTIIOONN  
Chapter 3 took you on a brief tour of some of RealFlight G2 Lite’s most popular 
features. This chapter will provide you with a broad overview of all RealFlight G2 
Lite features, and advise you how and where to find detailed information about the 
features that most interest you. 

 

PPRROOGGRRAAMM  FFEEAATTUURREESS  
 

SUMMARY OF FEATURES 

 Graphics technology – RealFlight G2 Lite takes complete advantage 
of today’s state-of-the-art 3D accelerated video cards, providing the 
smoothest and most realistic flight experience possible. RealFlight G2 
Lite uses incredibly detailed, 24-bit textures on aircraft, trees, buildings 
and landscape to add to the authenticity.  

 Uses VirtualRevolutionTM sound technology-- Doppler-correct stereo 
sounds heighten the realistic effect with true sound recordings of 2-
stroke, 4-stroke, turbine, electric, ducted fan and gasoline engines.    
And as the aircraft crosses the field, the engine sound follows, just like 
its R/C counterpart.  Aside from the various ambient noises such as 
other pilots conversing and birds chirping, RealFlight G2 Lite includes 
numerous CD-quality soundtracks in a variety of musical styles and 
original compositions. 

 RotoSonics™ technology-- recreating distinctive engine/blade sounds 
with startling accuracy.  Sounds so lifelike, you’ll swear you are at the 
field! 

 Uses RealPhysicsTM technology-- True to the physics of flight, 
RealFlight G2 Lite’s RealPhysics™ technology performs hundreds of 
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thousands of floating point operations each second. RealPhysics 
delivering sizzling real time flight performance and accuracy.   

 VFI (Virtual Flight Instructor) -- VFI gives you personal flight 
lessons from two of the R/C industry’s leading experts. Using VFI, you 
can select a maneuver from an extensive list.  VFI then demonstrates 
the maneuver onscreen, performed by an expert. While you watch, the 
voice of the pilot/instructor will explain how to perform the maneuver. 
You can even watch your instructor’s control stick movements in real 
time to determine proper stick input! If you want, you can fly your own 
aircraft right alongside the instructor’s aircraft, mimicking the 
instructor’s control inputs.     

 Collision Detection-- G2 allows you to activate collision detection for 
all scenery objects in your airfield.  When you activate collision 
detection, your aircraft will crash when it “bumps” any of the objects. 

 NavGuides- Options range from altitude and airspeed, to engine rpm.  
While you can’t do this with a real R/C aircraft, this feature improves 
you ability to “see” what is going on in your virtual world. 

 Binocular View- You can open up a picture-in-picture display that 
displays the unaltered orientation of the aircraft.   

 Control Panel-- RealFlight G2 Lite’s Control Panel allows for easy 
one-click program upgrading, online registration, and technical support. 

 Animated control surfaces and retracts— Control surfaces, retracts, 
propellers, and rotor blades move for added realism.  

 Aircraft exhaust/smoke—You can control the color, density, “hang 
time”, etc. of airplane and helicopter smoke and exhaust. 

 Extensive Help materials-- RealFlight G2 Lite features extensive 
online tooltips and diagrams, a detailed manual, and technical support 
to enhance your enjoyment of the program. 

 

WINDOWS® XP, 2000, ME AND 98 COMPATIBLE 

RealFlight G2 Lite is a native 32-bit program, designed for Windows 
XP/2000/ME/98. It uses Microsoft’s DirectX 8.1 to provide cutting-edge graphics 
realism. 

 

GRAPHICS 

 Supports Gouraud shading, bilinear textures, and dithering. 

 High quality 3D objects that you can situate anywhere you wish.   

 Realistic shading on all objects, including the airplanes and helis. 

 Transparency.  RealFlight G2 Lite uses transparency to model the rotor 
blades of the helicopter, the airplane propellers, exhaust and smoke 
from the aircraft, aircraft canopies, and atmospheric effects such as 
rainbows. 

 High-resolution graphics, including visible panel lines and moving 
control surfaces, for added realism and authenticity. 
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 Optimization-- Graphics Optimization sliders allow the user to 
customize the resolution of the textures, the graphics, and the terrain 
independently to achieve the most realistic look and “feel” for the 
simulation.  The controls also allow the user to tailor the program to 
optimize the performance to his/her PC. 

 Airplanes feature moveable control surfaces such as: ailerons, 
elevators, rudders, etc., as well as movable props, rotors and retracts. 
These add to the authenticity.  

SOUND 

 Employs Doppler-correct VirtualRevolution sound technology, 
heightening the realistic effect with true recordings of a variety of 
power plants throughout their RPM range. The recorded power plants 
include everything from 2-stroke and 4-stroke engines to actual 
turbines.   

 RotoSonics creates realistic helicopter sounds, accurately modeling the 
sounds of auto-rotations as well as other aggressive maneuvers. 

 CD-quality soundtrack features a variety of musical styles and original 
compositions; includes ambient sounds typically heard at flying sites. 

 Doppler-correct stereo effects.  As the aircraft crosses the field, the 
engine sounds follow; just like its R/C counterpart. 

PHYSICS 

 The exclusive RealPhysics  technology calculates hundreds of 
thousands of floating point operations each second, delivering sizzling 
real time flight performance and unmatched accuracy. 

 RealFlight G2 Lite’s physics have undergone countless of hours of 
testing and revisions to ensure that the models not only have a lifelike 
appearance but also perform just like their r/c counterparts as well. 

 RealFlight G2 Lite features detailed collision detection. Fly your heli 
around inside the barn, but don’t touch the walls! 

AIRCRAFT SKILL LEVELS 

 Three skill levels for every aircraft.  This allows you to select entry-
level aircraft when you first starting off, and then progress to more 
advanced skill levels as your R/C abilities improve. 

 RealFlight G2 Lite’s skill level settings mimic the actual performance 
of the aircraft for that respective skill level.  For example, an entry-
level airplane would be more docile and forgiving for a given set of 
stick inputs.  An advanced airplane, however, will fly faster and 
respond more rapidly and aggressively to controller input. 

 

. 
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CCOONNTTRROOLLLLEERR  FFEEAATTUURREESS  
All versions of RealFlight G2 Lite come with Great Planes’s USB InterLink 
Controller by Futaba. This revolutionary controller brings you: 

 Full USB compatibility. The InterLink Controller plugs directly into 
your computer’s USB port with little, if any, additional setup required. 

 Use the controller by itself as a high quality “mockup” R/C radio for 
controlling RealFlight G2 Lite. Realistic transmitter features include a 
three-position switch, rotary knob and adjustable stick length. 

 Or, use your own FM or FM compatible, 4-10 channel R/C radio 
transmitter to control RealFlight G2 Lite, using the InterLink 
controller’s built-in interface. 

 High-speed data transfer ensures rapid, digitally precise response to 
your control input. 

 Hot pluggable—connect/disconnect your InterLink controller without 
shutting down or rebooting your PC.  

 

GGRRAAPPHHIICCSS  AANNDD  SSOOUUNNDD  QQUUAALLIITTYY  
The makers of RealFlight G2 Lite continually work to bring you the most realistic 
graphics and sound possible, since we feel that these are also important contributions 
to your simulation experience. To do so, we take full advantage of modern video and 
sound hardware. However, we still provide you with extensive, detailed control over 
graphics and sound quality, so that you can usefully run RealFlight G2 Lite on 
computers with widely varying speed, power and performance. 

FRAME RATE 

Frame rate is usually described as how fast the computer can compute and display a 
new “snapshot”.  In other words, it is the rate at which frames (the individual 
pictures that are shown in sequence to create the illusion of motion) are displayed in 
a film or video.  Frame rate is measured in frames per second (fps).  Like a movie 
picture, when stills are quickly flashed by, RealFlight G2 Lite creates a sequence of 
frames that provide the illusion of motion.  Television is flickering the pictures at 30 
times per second (30FPS).  A typical movie theater displays about 24/48FPS.  
RealFlight G2 Lite can produce output ranging from 2FPS to over 150FPS. 

Frame rate is a function of many things and cannot be “set” by the end user.  It is a 
combination of: 

 Computer Speed 

 Video card speed 

 Sound card speed 

 How many optional airport items are selected 

  3D technology selected 

 Aircraft selection 
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In order for the simulator to work best, you should run at a high enough frame rate so 
that you do not notice the picture moving from one frame to the next.  Rather, it 
should appear as a smooth, fluid motion.  If you observe any “stop-and-go” motions 
from the simulation, there are several things that may improve the frame rate. For 
more information, please see “Improving RealFlight® Lite Performance” on page 
99. 

GRAPHICS QUALITY 

RealFlight G2 Lite is capable of many different levels of graphics quality, some of 
which are entirely dependent upon the video hardware and monitor used.  RealFlight 
G2 Lite allows you to control a multitude of graphics variables in order to configure 
the simulation to attain the highest possible performance. You can control these 
variables using either the Graphics Optimizations or Direct3D items in the 
Options menu.  

SOUND QUALITY 

In order to use your sound card with RealFlight G2 Lite, the sound card must support 
Microsoft’s DirectSound.  Many sound cards accelerate the mixing of multiple 
sounds.  RealFlight G2 Lite will take advantage of any acceleration that the card 
supports.  This acceleration will free up your CPU, thereby increasing your frame 
rate. 

 

TTEECCHHNNIICCAALL  SSUUPPPPOORRTT  
Besides providing the best R/C simulator, we sincerely feel that we provide the most 
extensive product support for any R/C simulator. Since cards, drivers, operating 
systems, etc. are always changing, we work hard to keep our support up to date on 
the latest issues and problems RealFlight G2 Lite users might encounter. 

We provide a wide variety of sources for information, help and advice about 
installing, using, and resolving problems with RealFlight G2 Lite (as well as our 
other software products). These sources range from a detailed, publicly accessible 
product knowledge base, to live technical support, to peer chat and message boards. 
Should you encounter any problems with RealFlight G2 Lite, you can access any of 
these sources, many with a click of the mouse or telephone call.  

To learn more about RealFlight G2 Lite’s many support options, please see 
“Appendix C. If You Experience Difficulties With RealFlight G2 Lite…” (page 95). 
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CCHHAAPPTTEERR  55..  TTHHEE  IINNTTEERRLLIINNKK  

CCOONNTTRROOLLLLEERR  

TTHHEE  IINNTTEERRLLIINNKK  CCOONNTTRROOLLLLEERR——DDEESSIIGGNNEEDD  FFOORR  RR//CC  
By definition, the R/C transmitter is a key component in all types of R/C flying. This 
unique method of control is part of what separates R/C from every other type of 
aviation. Consequently, a realistically simulated transmitter is an important key to an 
authentic simulation of the R/C experience. 

With this in mind, we at Great Planes are proud to offer our revolutionary USB 
InterLink Controller, made by Futaba. All versions of RealFlight now come with this 
state-of-the-art control system. We’ve designed the InterLink from the ground up to 
meet the needs of the R/C purist. We believe that no other R/C simulator control 
method goes farther to enrich your R/C simulator experience. 

The controller is so unique that it is Patent-Pending. 

 

The InterLink Controller 

Features of the InterLink Controller: 

 USB compatibility and convenience. The InterLink offers the “plug 
and play” convenience, “hot pluggable” installation and removal, as 
well as the high-speed digital performance made possible by Universal 
Serial Bus (USB) technology. 
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 High quality “mockup” transmitter. Use the InterLink Controller by 
itself as a pseudo R/C transmitter, with the controls you expect in a 
standard FM 8-channel radio. This controller features two two-position 
switches, one three-position switch and a rotary knob, plus knurled 
control sticks with adjustable length. 

 Built-in Transmitter interface. If you so choose, you can use your 
own FM or FM-compatible R/C transmitter to control RealFlight G2 
Lite, using the InterLink Controller’s built-in interface. You can even 
switch back and forth between the pseudo controller and your own 
transmitter! 

 Easy setup and use. In most cases you don’t even have to calibrate the 
InterLink Controller, unlike other computer joysticks. Simply plug it in 
and go! 

 Simulate sophisticated computer radios. The InterLink, used in 
conjunction with RealFlight G2 Lite, allows you to simulate the 
programmability (mixing, exponential, etc.) of sophisticated computer 
radios.  

The following sections describe how to set up and use the InterLink controller with 
RealFlight G2 Lite. If you want to use the InterLink as a mockup controller, see “The 
InterLink Controller (Joystick Mode)” on page 28. If you want to use your own R/C 
transmitter with RealFlight G2 Lite, you’ll want to read “The InterLink Controller 
(Interface Mode)” on page 29. 

Finally, this chapter concludes with a collection of pointers and advice that will help 
you get the most out of your InterLink controller (“InterLink Controller Hints and 
Tips” on page 32). 

SSTTAARRTT  FFLLYYIINNGG!!  
When you start RealFlight G2 Lite for the first time, it will automatically calibrate 
the InterLink controller. Simply add throttle and start flying right away. Sample the 
different aircraft; if you like, experiment with the switches and knobs to determine 
their functions.  

RealFlight Lite, by default, starts out in “Joystick Mode”, which gives you this 
plug-and-play capability. That is, Joystick Mode allows the InterLink to control all 
functions associated with the flight of your aircraft.  Read more about this on page 
28. 

You can also use your own transmitter to control RealFlight G2 Lite.  This is called 
“Interface Mode”. Read more about this on page 29. 

 

JJOOYYSSTTIICCKK  VVSS..  IINNTTEERRFFAACCEE  MMOODDEE  
RealFlight allows you to quickly and easily change the method in which you control 
the action of the simulation. RealFlight G2Lite offers two control modes: 

 Joystick Mode. Using the InterLink in Joystick Mode, RealFlight G2 
Lite accepts control from the sticks, switches and knob on the InterLink 
controller.  This is the default mode when you install RealFlight G2 
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Lite, and we’ve pre-calibrated this mode for you. Consequently, it’s 
ready to fly “out of the box”-- set up or adjustment is unnecessary. 

 Interface Mode. Using the InterLink in Interface Mode, RealFlight G2 
Lite accepts commands from your own transmitter.  To use this mode, 
your transmitter must be connected to the InterLink Controller via the 
InterLink’s built-in interface. This is an optional use of the InterLink. 
Using Interface Mode takes slightly more setup, and understanding of 
your radio, than Joystick Mode. 

To toggle between modes, run RealFlight G2 Lite. Make sure that your radio is 
connected and turned “on” (some transmitters will automatically power up when you 
insert the interface cord; other transmitters will require that you turn them “on”). 
Next, select Controller Calibration… from RealFlight G2 Lite’s Options menu. 
The following dialog will appear: 

 

 

Under Controller Type, select Interlink Controller (Interface mode).” This will 
transfer control to your actual transmitter. Later on, you will be able to toggle 
between the InterLink dummy control box and your transmitter by selecting Joystick 
or Interface mode from this dialog. 

 

TTHHEE  IINNTTEERRLLIINNKK  CCOONNTTRROOLLLLEERR  ((JJOOYYSSTTIICCKK  MMOODDEE))  
In Joystick Mode, RealFlight G2 Lite accepts control from the sticks, switches and 
rotary knob on the InterLink controller.  This is the default mode when you install 
RealFlight G2 Lite and is pre-calibrated for you. 
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The RealFlight G2 Lite software actually does all the radio processing to measure the 
raw stick/switch inputs from the InterLink Controller, and processes them to produce 
the servo outputs that are used to control the aircraft.   

For example, helicopters ordinarily use a great deal of mixing; this mixing normally 
occurs on your computer radio. When RealFlight G2 Lite uses the InterLink’s 
Joystick Mode, the mixing is done by the RealFlight G2 Lite software itself, not by 
the InterLink Controller.   

Each aircraft in RealFlight Lite has its own unique Software Radio Program that 
maps the raw stick inputs from the InterLink Controller into the correct servos for 
that particular aircraft. 

 

 

TTHHEE  IINNTTEERRLLIINNKK  CCOONNTTRROOLLLLEERR  ((IINNTTEERRFFAACCEE  MMOODDEE))  
This exciting feature allows you to plug your own R/C transmitter into the back of 
the InterLink Controller. You can then use your transmitter to control RealFlight G2 
Lite aircraft. With Universal Serial Bus (USB) connectivity, the InterLink controller 
offers high resolution, rapid data transfer from your transmitter to the PC, and rapid 
response from the simulated aircraft. 

Using your own radio adds some complexity and initial configuration setup (when 
compared to Joystick Mode). 

INTERFACE MODE FEATURES AND TERMINOLOGY 
The Interface Mode can also be referred to as the “Joystick Emulation Interface” 
for purposes this description (not to be confused with “Joystick Mode” in the 
previous section). Here is a quick chart that will help you decide which mode to use. 

 InterLink 
Joystick Mode 

InterLink 
Interface Mode:  
Joystick 
Emulation 
Interface 

Radio used to Fly InterLink 
Controller 

Your own R/C 
radio 
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Ease of 
Configuration 

Very Easy/Pre-
calibrated 

Medium.  Must 
calibrate and 
setup radio once 

 Fly Stock aircraft 
without 
Modification 

Yes Yes 

Gives you the feel 
of your own radio 

No Yes 

Puts “wear and 
tear” on your own 
transmitter 

No Yes 

Allows you to 
perform mixing in 
your own radio 

No No 

R/C transmitter 
required 

No Required: 4-8 
channels.  
Computer radio 
not required 

Additional 
Information 

Page 28 Page 30 

 

IINNTTEERRFFAACCEE  MMOODDEE::  JJOOYYSSTTIICCKK  EEMMUULLAATTIIOONN  IINNTTEERRFFAACCEE  
The purpose of the Joystick Emulation Interface is to create a program on your 
own R/C transmitter to provide RealFlight G2 Lite with raw stick inputs. This 
enables RealFlight G2 Lite to use its own “software radio” to control all of the stock 
aircraft. 

This allows you to use a single model memory, or program, on your R/C transmitter 
to control, without modification, all of the stock aircraft in RealFlight.  To do this, 
RealFlight walks you through an “Interface Wizard” that helps you to properly set 
up your transmitter to “talk” with RealFlight. 

CALIBRATION VS. INTERFACE WIZARD 

Interface Wizard 

The “Interface Wizard” is a multiple-step process that helps the RealFlight G2 Lite 
software to determine which channel on your radio will be controlling which channel 
in RealFlight G2 Lite.  This is necessary for the Joystick Emulation Interface to 
function properly. 

 

When you calibrate 

Because R/C transmitters vary by manufacturer, model, and setup, you must provide 
some information about your transmitter.  This will allow RealFlight G2 Lite to 
function properly. Consequently, when you first activate Interface Mode, RealFlight 
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G2 Lite will prompt you to calibrate your controller and assign input channels. 
Unless you switch transmitters, or want to change something in the future, you’ll 
only have to do this once. RealFlight G2 Lite will lead you through the necessary 
steps (see below). 

 

INTERFACE CALIBRATION 
When you calibrate your R/C transmitter with RealFlight G2 Lite, you are, in 
essence, telling RealFlight G2 Lite what the maximum, minimum, and center values 
are for each channel on your particular radio.  There are a number of pre-defined 
radios listed in the dialog.  If your radio is amongst these selections, RealFlight G2 
Lite will auto-calibrate it for you.   

When you first activate the Interface mode, RealFlight G2 Lite will prompt you with 
the following dialog: 

 

 

RealFlight G2 Lite is capable of automatically calibrating itself to many popular 
manufacturers and models of R/C transmitters. If your transmitter appears on the list, 
please select it and click OK. RealFlight G2 Lite will automatically complete the 
calibration.  

If you can’t find your radio on the list, you will have to complete the calibration 
manually. Check the Manually Calibrate Radio box and click OK. RealFlight G2 
Lite will then display a “wizard” that guides you through the calibration process. 

You can also get to this dialog by clicking on the Calibrate button in the 
Controllers Dialog (Options menu/Calibrate Controller). 

In any case, if this is the first time you are using your transmitter to control 
RealFlight G2 Lite, make sure that you leave the Run Interface Wizard box 
checked. 

Once calibrated, you will not have to re-calibrate your transmitter again (Unless you 
use a different transmitter in the future) 
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INTERFACE WIZARD 
This is a multiple step process that determines which channel on your transmitter 
will control which channel in RealFlight Lite.  This is necessary for the Joystick 
Emulation Interface to work properly. 

 

Before using the wizard, you will need to create a new program or model memory on 
your R/C transmitter. Call it “RFJOY” or something similar. Additionally, please 
MAKE SURE THAT THIS NEW PROGRAM: 

 Is an “airplane” program--you don’t want a heli program with all of its 
mixing (since all the mixing will be performed by the RealFlight® 
software); 

 Has all mixing turned “off”; 

 Has trims centered; 

 Has ATVs set to 100%; 

 Has Dual Rates and expo turned “off” (these can both be emulated in 
the RealFlight G2 Lite Software Radio). 

 

To start this wizard, make sure the Interface mode is selected (Options menu/ 
Calibrate Controller) and then click the Interface Wizard button.  Follow the 
instructions in the wizard, making sure that you read all the instructions in each step. 
Note: you may have to use the scroll bar to read an entire instruction. 

Once you have finished this wizard, it is best if you never modify the “RFJOY” radio 
program again.  If you want to modify a particular aircraft, then edit the Software 
Radio in RealFlight G2 Lite instead. This is because a change in this “RFJOY” 
program will affect every RealFlight G2 Lite aircraft flown with this transmitter. 
Changes to the Software Radio only affect the aircraft whose radio you have edited. 

To fly any of the stock aircraft, simply switch your radio to the “RFJOY” program. 
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IINNTTEERRLLIINNKK  CCOONNTTRROOLLLLEERR  HHIINNTTSS  AANNDD  TTIIPPSS  

WHAT IF MY TRANSMITTER HAS FEWER THAN EIGHT CHANNELS?  
 

This issue arises when you use your own transmitter to control RealFlight G2 Lite. 

RealFlight G2 Lite supports up to eight controller channels. Many simulated aircraft 
use all eight channels. If, however, your transmitter has fewer than eight channels, 
you can still fully control RealFlight G2 Lite aircraft. The way to do is to map some 
of the channels to keys on your computer keyboard. 

First, open the Calibration dialog by selecting Controller Calibration… from the 
RealFlight G2 Lite Options menu. Next, ensure that you are set to Interface Mode. 
Click the Interface Wizard button, and then step through the wizard until you come 
to the page that controls the missing channel. 

 

Your controller may not have a channel available for some functions. 

Under Controlled By: select the key that you want to control this channel.  

Repeat this for every “missing” channel until all channels are functioning properly. 
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CCHHAAPPTTEERR  66..    TTHHEE  AAIIRRPPOORRTT  MMEENNUU  

AAIIRRPPOORRTT  MMEENNUU  OOVVEERRVVIIEEWW  
The Airport menu allows you to access all airport-related features and options. 
When you open up the pull-down menu, you will see something like this: 

 

The items in this menu are:   

 Select Airport… 

 Item Visibility 

 Show Trees 

 Show Fog    

 3D Terrain 

 Weather Conditions… 

 Exit 

 Airport MRU 

The following sections describe the function or purpose of each of these items. 
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SSEELLEECCTT  AAIIRRPPOORRTT……  
When you click on Select Airport… the following dialog appears: 

 

This dialog lets you choose the flying site and airport options that you wish to use for 
your flight.  Each airport offers its own unique characteristics and challenges.  

The list at the top of the dialog list displays all of the flying sites available. (In the 
example above, the user has selected an airport named “Black Rock.”)  

ADDITIONAL AIRPORT OPTIONS 

Select the additional airport items that you wish to appear at your flying site. This list 
may contain scenery items (buildings, runways, etc.) or foliage (trees, shrubs, etc.). 
The more objects that appear on the flying site the more realistic it may appear.  
However, additional objects may slow down the rendering, as they require more time 
and computer power to process. 

When you select items in this list, you are deciding whether or not to show or hide 
objects that are already in this flying field. 

 

IITTEEMM  VVIISSIIBBIILLIITTYY  
Use this item to determine whether to show or hide scenery objects in the airport. 
Selecting this item creates a submenu with a list of items you can show (make 
visible) or hide (remove from visibility). To show items, select them (check them in 
the submenu). Conversely, to hide items uncheck them. 
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There are two important concepts that will help you use this command effectively. 

The items on the submenu list are groups, not individual objects. Groups are 
collections of airport objects (buildings, trees, roads, fences, etc.). 

  

SSHHOOWW  TTRREEEESS  
This item lets you determine whether or not the trees/foliage will be visible.  This is 
the universal controller of all the trees/foliage.  If this item is checked, then the 
trees/foliage will be visible.   

SSHHOOWW  FFOOGG  
Select this item to toggle “on/off” the Fog options for RealFlight G2 Lite.  This 
option may also be toggled “on/off” with the keyboard “F”.  Not all video cards will 
support the fog option. 

 

33DD  TTEERRRRAAIINN  
Select this item to choose whether or not the current airport will be rendered in the 
3D terrain style or PhotoField.   

PhotoField displays the flying sites using photographic-quality panoramic views on 
a flat-style terrain.  A PhotoField flying site does not require as powerful a computer 
as does the 3D style terrain and may assist in increasing the frame rate of your 
simulation. 

The 3D Terrains offer actual three-dimensional topography.  The 3D terrains offer 
greater realism and design flexibility, however, they do require a stronger computer 
in order to maintain an acceptable frame rate. 

Additionally, some users actually prefer the look of the PhotoField sites to the 3D 
style terrains.  We suggest that you experiment with both to determine your personal 
preference. 

WWEEAATTHHEERR  CCOONNDDIITTIIOONNSS  
Select this item to adjust the weather conditions such as wind speed, gust strength, 
wind direction and thermal activity. 
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AVERAGE WIND DIRECTION 

This indicates the prevailing direction of the wind.  “0” degrees is North, “90” 
degrees is East, “180” degrees is South and “270” degrees is West.  The prevailing 
direction may be adjusted anywhere between “0” degrees and “360” degrees. 

VARIABLE DIRECTION 

This indicates, in degrees, how the wind direction will vary.  If this field reads “0” 
degrees, the wind direction will remain steady.  However, if the field indicates “360” 
degrees, then the wind may vary through all directions. 

WIND SPEED 

This field indicates the prevailing wind speed.  This is the constant wind speed. 

GUSTS TO 

This indicates the wind gust speed.  The wind speed will intermittently increase to 
this speed.  The Gust slider setting controls the frequency of the wind gusts. 

GUST SLIDER 

This slider is used to adjust the strength of the wind gusts.  If the slider is set to 
smooth, the simulation will provide an unrealistically smooth flight.  Gusty, on the 
other hand, will provide a simulation that will challenge even the most skilled of 
pilots. 

THERMAL ACTIVITY 

This slider indicates the current thermal activity.  If the slider is adjusted to the 
“higher” side of the settings, there are stronger thermal currents.  This is useful in 
flying thermal gliders.  The thermals appear in random locations and will have 
random strengths.  Over time, they will move from one place to another.  You can 
tell when your plane has entered a thermal by watching the plane carefully.  When 
the plane starts to rise quickly, then you have found a thermal.  Quickly turn around 
and try to stay in that thermal to gain altitude. 
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EEXXIITT  
Exit the program entirely.  

AAIIRRPPOORRTT  MMRRUU  
The last items on the Airport menu are names of airports you have previously used. 
In the graphic below, the user is currently flying at an airport named “Green Valley,” 
and has previously flown at “Rainbow Canyon”: 

 

If you select one of these airports, RealFlight G2 Lite will reload that airport. This is 
a shortcut that lets you rapidly switch between airports without using the Select 
Airport… item.
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CCHHAAPPTTEERR  77..    TTHHEE  AAIIRRCCRRAAFFTT  MMEENNUU  

AAIIRRCCRRAAFFTT  MMEENNUU  OOVVEERRVVIIEEWW  
This menu accesses all aircraft related features and options.  When you open the 
Aircraft menu, your display will be similar to the following: 

 

 

The items in this menu are: 

 Select Aircraft… 

 Aircraft Smoke 

 Show Exhaust 

 Reset Position 

 Kill Engine 

When you select Aircraft Selection…, the following dialog appears: 
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The main purpose of this dialog is to help you select the aircraft you wish to fly. This 
dialog also enables you to choose a skill level.   

AIRCRAFT SELECTION  

From the list in the upper left side of the dialog, select the aircraft that you want to 
fly. Options include everything from a gentle PT-40 Trainer to a relaxing Spirit™ 
glider.  Or, choose a heart-stopping CAP 232, or a sizzling-hot turbine fan-powered 
jet.  Every aircraft has its own unique flying characteristics as well as special 
functions.  

The panel in the upper right side shows a graphic representation of the selected 
aircraft. 

SKILL LEVEL (TYPE) 

Choose from three skill levels for every aircraft.  Each respective skill level selection 
will cause the airplane or helicopter to fly and respond accordingly.  Select Beginner 
and the aircraft will respond sluggishly (as well as appear larger on the screen).  If 
you select Intermediate or Advanced, however, the aircraft will fly faster and 
respond to the stick input more aggressively.  

DESCRIPTION 

This box describes the model and any special features it may have.  Consult this box 
to determine the switch layout of the selected aircraft, miscellaneous flight 
characteristics, etc.  
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AAIIRRCCRRAAFFTT  SSMMOOKKEE  
Selecting this check box will display the smoke from your aircraft. 

Smoke and exhaust are treated as different subjects in RealFlight.  Exhaust is the 
normal byproduct of burning fuel through an internal combustion engine.  Smoke is 
a denser emission caused by intentionally injecting smoke oil into the muffler. 

SSHHOOWW  EEXXHHAAUUSSTT  
Click on this item to show the airplane exhaust trails.  

If you want to turn off the airplane exhaust, click on this box to remove the check 
mark.  

  

RREESSEETT  PPOOSSIITTIIOONN  
Click on this item to reset the aircraft to the takeoff point.  You can accomplish the 
same task by pressing the keyboard’s space bar. 

If you want to change initial position, select Set Takeoff Position in the Airport 
menu. 

KKIILLLL  EENNGGIINNEE  
Click on this item to stop the motor from running.  This is useful in practicing dead-
stick landings in airplanes and in practicing auto-rotations for helicopters.  
Alternatively, you may also press the keyboard “K”. 

AAIIRRCCRRAAFFTT  MMRRUU  
The final items in the Aircraft menu indicate the most recently used aircraft. The 
first item is the aircraft you are currently flying; successive items are aircraft you 
have previously flown. You can load an aircraft by selecting it from this list. This is 
a shortcut that allows you to switch between favorite aircraft without using the Select 
Aircraft… menu item above. 
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CCHHAAPPTTEERR  88..    TTHHEE  OOPPTTIIOONNSS  MMEENNUU  

OOPPTTIIOONNSS  MMEENNUU  OOVVEERRVVIIEEWW  
The Options menu controls several RealFlight G2 Lite program features. Items in 
this menu include:  

 

 Direct 3D… 

 Controller Calibration… 

 Graphics Optimizations… 

 Miscellaneous… 

 Run in Window 

 Enable Collisions 

 Virtual Flight Instructor… 

 Music/Sound… 
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DDIIRREECCTT33DD  
Select this item to control settings for your 3D video card.   

 

 

CURRENT MODE 

This displays the current screen width, the height and the bits per pixel.  
Additionally, if your monitor’s current refresh rate is known, it will also be 
displayed. 

ADAPTER 

If you have more than one Direct3D compatible video card, they will both be listed 
here.  Please choose the card you wish to use. 

RENDERING DEVICE 

Each card can have different devices, although most cards will only offer the HAL 
interface. 

USE HARDWARE VERTEX PROCESSING IF AVAILABLE 

Check this box if you wish to use the hardware vertex processing.  Most of the time 
you want this option enabled.  If you experience difficulties with the graphics, try 
disabling this option.  If disabling this option fixes your problem, then contact your 
video card manufacture and notify them of this difficulty. 
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You can look in the Graphics Optimizations dialog (See “Graphics Optimizations” 
on page 51 to see if your card supports Hardware Vertex Processing). 

RENDERING MODE 

RealFlight G2 Lite can be run in Window mode, or in Full Screen Mode.   

WINDOW MODE 

The Window Mode screen size is dictated by the settings that you have selected in 
the Display Properties for your monitor.  If run in Window Mode, the RealFlight G2 
Lite menus will always appear at the top of the screen for easy access.  You can at 
any time change the resolution of the desktop by going to Start 
Menu/Settings/ControlPanel/Display. 

Please note:  if you are using a 32 Color Bit display mode for your desktop, it will 
not render as quickly as choosing a 16 Color Bit display mode. 

FULL SCREEN MODE 

Selecting this option will allow RealFlight G2 Lite to use the entire monitor screen.  
If you are running in Full Screen Mode, the RealFlight G2 Lite menus will not 
appear on the screen.  To access the menu, press either the “ESCape” key or the 
“ALT” key on the keyboard.   

RESOLUTION  

In full screen mode only, you can use this control to adjust the screen resolution and 
color depth.  If your frame rate is unacceptably low, you can improve it by reducing 
the resolution or color depth.  This will reduce some of the rendering required of 
your video card.  

Resolution determines both the sharpness of the picture and how many colors will be 
used to render the picture.  To illustrate resolution, here is the same image of a plane 
at two different resolutions. 

  

640 x 400 Resolution 1600 x 1200 Resolution 
 

Notice how much clearer the higher resolution picture is.  The problem with high 
resolutions is that on some computers, it makes the program run much slower.  
Selecting the ideal resolution for your computer requires a delicate balance between 
quality and speed. 

REFRESH RATE 

Adjust the refresh rate of you monitor (Full Screen Mode only).  
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This controls only the refresh rate, not the frame rate.  

Refresh rate is the number of times per second that your monitor retraces its video 
display. Your video hardware (monitor and graphics card) dictates what refresh rates 
you can use.   

Frame rate is the number of times per second that RealFlight G2 Lite creates a 
different picture to display on your monitor. Frame rate is determined by the speed of 
your CPU and graphics card, and how many RealFlight G2 Lite options are 
activated.   

Use this control to set the refresh rate for Full Screen Mode. If RealFlight G2 Lite is 
unable to determine what refresh rates your card supports, this control will display 
"0." Higher refresh rates have less "flicker” and usually cause less eye strain. 

For suggestions on increasing RealFlight G2 Lite's frame rate, see “Improving 
RealFlight® Lite Performance” on page 99.   

We suggest that you test a variety of resolutions and color options to achieve the 
optimum performance and setup for your system. 

CCOONNTTRROOLLLLEERR  CCAALLIIBBRRAATTIIOONN  
This page lets you set up your controller, and verify that your controller is operating 
correctly. This is an important dialog. If you use your own transmitter to control 
RealFlight G2 Lite, and it is not set up correctly, your aircraft will fly erratically. 

If you are using the InterLink controller as a standalone mockup transmitter, you 
should not normally need to calibrate it. If you are using your own transmitter to 
control RealFlight G2 Lite, you may need to calibrate it if RealFlight G2 Lite does 
not have a pre-calibrated setting for your transmitter’s manufacturer and model. 

 

Appearance of the Controller Calibration dialog in Joystick mode 
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Appearance of the Controller Calibration dialog in Interface mode 

CONTROLLER TYPE 

Select the controller type that you wish to use.  In Joystick Mode, RealFlight G2 
Lite accepts input from the InterLink controller box. In Interface Mode, RealFlight 
G2 Lite accepts control from your R/C transmitter (assuming it is connected to the 
InterLink controller’s “buddy box” interface).  

When you change between Joystick and Interface mode, some of the controls in this 
dialog will change (see diagrams above). For more details, see “Joystick vs. 
Interface Mode” on page 27.  

STICK MAPPING (JOYSTICK MODE ONLY) 

This indicates the mode or type of joystick that you will be using for RealFlight G2 
Lite.  Select the controller mode that you wish to use.  A description of the various 
modes follows.   

 Transmitter Mode 1 (Europe, Asia) - Select this option to use the 
controller for the joystick.  This requires the joystick to have four 
distinct axes.  Use this option if you have purchased the Futaba® 
controller Mode 1 version of this software, or if you have converted 
your controller to mode 1.  Mode 1 transmitters have aileron and 
throttle on the right stick, and rudder and elevator on the left stick. 

 Transmitter Mode 2 (USA) - Select this option to use a mode 2 
controller for the joystick.  This requires the joystick to have four 
distinct axes.  Use this option if you have purchased the Futaba® mode 
2 controller version of this software.  Mode 2 transmitters have aileron 
and elevator on the right stick; rudder and throttle on the left stick. 

 Transmitter Mode 3 - Select this option to use the controller for the 
joystick.  This requires the joystick to have four distinct axes.  In order 
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to use Mode 3, you will need to have purchased the “Mode 2” version 
of the controller.  Mode 3 transmitters have rudder and elevator on the 
right stick; aileron and throttle on the left stick. 

 Transmitter Mode 4 - Select this option to use the controller for the 
joystick.  This requires the joystick to have four distinct axes.  In order 
to use Mode 4, you will need to have converted a “Mode 1” version of 
the controller.  Mode 4 transmitters have rudder and throttle on the 
right stick, and aileron and elevator on the left stick. 

 Custom - Choose this if you have a custom joystick.  This setting may 
also be used if you want to change the way the controller sticks are 
mapped. 

RADIO MANUFACTURER (INTERFACE MODE ONLY) 

Use this setting to select the company that manufactures your R/C transmitter.  

CHANNEL VALUES 

This preview window shows you the input channels as they are read in real time 
from your controller or joystick.   If you move the physical sticks on the controller 
and the meters on the screen do not move, then your joystick is not set up correctly.  
If your sticks move in the wrong direction or do not move all the way to the 
extremes, then you may not have calibrated the joystick correctly or you may have to 
perform additional calibration using the Interface Wizard (interface mode only). 

There is also a preview of the switches as well.  When a switch is “on” RealFlight 
G2 Lite will highlight the respective button.  For more information on the 
switch/knob layout of the InterLink controller, see “Chapter 5. The InterLink 
Controller” on page 26. 

CALIBRATE 

You can, but should not normally need to calibrate the InterLink controller when you 
use it as a standalone mockup transmitter. You may need to calibrate your own 
transmitter the first time you use it to control RealFlight G2 Lite. Click on the 
Calibrate button to initiate the calibration sequence.  Follow the onscreen 
instructions. For more information about calibration, see “Interface Calibration” on 
page 31. 

INTERFACE WIZARD (INTERFACE MODE ONLY) 

When you use your own R/C transmitter to control RealFlight G2 Lite, you will need 
to assign its input channels. The Interface Wizard is a sequence of dialogs that 
helps you to do so. 

This process is included as part of the calibration procedure the first time you use 
your own R/C transmitter to control RealFlight G2 Lite. You normally only need to 
do this once, but you can click the button to enter the wizard if, for some reason, you 
want to change something.  

For more information about the Interface Wizard, see “Interface Wizard” on page 
30. 
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GGRRAAPPHHIICCSS  OOPPTTIIMMIIZZAATTIIOONNSS  
Select this item to access the Graphics Optimizations dialog: 

 

This dialog controls a wide variety of the graphics performance options for 
RealFlight G2 Lite.   

RealFlight G2 Lite attempts to optimize your system’s performance, however, these 
controls will enable you to further fine-tune the simulation to suit your personal 
taste. 

TEXTURE QUALITY SLIDER 

This slider controls the texture quality of RealFlight G2 Lite.  Moving the slider to 
the right will increase the texture resolution.  Higher resolutions will improve the 
realistic appearance, however, they may also slow down the frame rate as well.  

GRAPHICS QUALITY SLIDER 

This slider controls several graphics aspects of the RealFlight G2 Lite simulation (for 
example, shadow quality), allowing you to tweak the simulation for optimum 
performance.  Higher graphics quality will improve the realism, however, it may also 
slow down the frame rate as well. 

TERRAIN DENSITY SLIDER 

Increasing the values of the Terrain Density will increase the resolution of the 
terrain thereby giving it a more life-like appearance.  Higher resolution will improve 
the realism, however, it may also slow down the frame rate as well. 

USE MIPMAPS 

Click this check box to activate the MipMaps feature.  Turning this feature “off” 
may cause unwanted “sparkling” on distant objects, or on object surfaces that are 
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viewed at large angles. Using MipMaps improves realism, but may slow down your 
computer’s frame rate. 

USE DETAIL TEXTURES 

Click this check box to use detailed textures at your flying site.  This increases the 
detail and sharpness on surfaces (the ground in particular).  Using the Detailed 
Textures feature improves realism, but may slow down your computer’s frame rate. 

USE SPECULAR HIGHLIGHTING 

Click this check box to use the Specular Highlighting feature.  This feature makes 
smooth objects appear shiny in reflected light.   Using the Specular Highlighting 
feature improves realism, but may slow down the frame rate. 

SHOW AIRPORT OBJECTS SHADOWS 

Click this check box to show the shadows that are cast by the airport objects such as 
buildings, walls, etc.  Using the feature improves realism, but may slow down the 
frame rate. 

SHOW TREE SHADOWS 

Click this check box to show the shadows that are cast by the trees.  Using the 
feature improves realism, but may slow down the frame rate. 

GRAPHICS CARD INFO 

This panel displays information pertaining to your graphics card.  This is an easy 
way to determine whether or not your current graphics card will support a certain 
feature or function. 

MMIISSCCEELLLLAANNEEOOUUSS  
Select this item to access the Miscellaneous options dialog: 
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This dialog allows you to adjust miscellaneous options such as language, units of 
measure, adjust the landing difficulty, etc. 

LANGUAGE 

This indicates the language that RealFlight G2 Lite will use in all of its dialogs.  The 
language that appears here will reflect the language that was selected during the 
installation process.  

PHYSICS RESOLUTION 

Adjusts how fast the physics are calculated.  The higher the percentage, the smoother 
the aircraft responds to aerodynamic and ground forces.   

Setting this parameter higher requires more computing power; 100% will work fine 
on most computers. However, on slower systems you may need to lower this value 
below 100% to maintain a normal frame rate.   

There is usually no need to exceed 100%.  Setting the percentage above 100% may 
slow down frame rate. 

TIME MULTIPLIER 

Indicates the percentage to adjust RealFlight G2 Lite’s visual time base.  Reducing 
this value allows you to create a “slow-motion” effect.  This slow-motion effect is 
useful when learning new skills or maneuvers, as you can slow the aircraft’s reaction 
time. 

AIRCRAFT CAN RUN OUT OF FUEL 

Check this box to allow your aircraft to run out of fuel.  If left unchecked, the model 
will be able to run indefinitely.  To adjust the size of the fuel tank, or battery power, 
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access the aircraft editing dialogs.  To do so, choose the Select Aircraft item in the 
Aircraft menu. 

LANDING DIFFICULTY SLIDER 

This slider adjusts the difficulty of landing the respective aircraft.  Entry-level pilots 
may wish to adjust the slider to the “easy” settings.  These settings are more 
forgiving and will allow the aircraft to survive mistakes that would normally crash an 
actual R/C aircraft.  The realistic settings, however, are not as forgiving and more 
closely mimic the response of an actual R/C aircraft.   

SHOW TIP OF THE DAY  

Click on this check box to turn “on/off” the RealFlight G2 Lite Tip of the Day.  
These tips are a sequence of helpful hints and tips on using RealFlight G2 Lite.  
These tips often call attention to overlooked, yet important, features and options. See 
also “Tip of the Day” on page 70. 

SHOW DIALOG TOOL TIPS 

Click on this check box to turn “on/off” the tooltips in RealFlight G2 Lite.  The 
tooltips are the yellow popup windows that appear when you place the mouse arrow 
over a dialog item or control.   

SHOW MENU TOOL TIPS  

Click on this check box to turn “on/off” the tooltips in RealFlight G2 Lite.  The 
tooltips are the yellow popup windows that appear when you place the mouse arrow 
over a menu item. 

RRUUNN  IINN  WWIINNDDOOWW      
Select this item to determine whether RealFlight G2 Lite will run in the Window 
Mode or in Full Screen Mode.  If checked, RealFlight G2 Lite will run in the 
Window Mode.  If unchecked, the program will run in Full Screen Mode. 

Please note, not all video cards support Full Screen or Windows Modes.  You may 
only use modes that your video card is capable of supporting.   

EENNAABBLLEE  CCOOLLLLIISSIIOONNSS  
Select this item to determine whether or not RealFlight G2 Lite’s Collision Detection 
feature is enabled.  G2 is capable of simulating collisions between aircraft, scenery 
objects, multiplayer aircraft and recorded aircraft.  Turning this feature “on” will add 
to the realism, however, on some computers it may slow down the frame rates.  If 
active, a check mark will appear to the left side of this selection. 

VVIIRRTTUUAALL  FFLLIIGGHHTT  IINNSSTTRRUUCCTTOORR™™  
Would you like to learn how to do a maneuver? With G2’s Virtual Flight 
Instructor feature, you’ll receive a personal flying lesson from a pro.   
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Mike Cross, an airplane designer and two-time IMAC freestyle champion, will take 
you through the fixed wing maneuvers.  Dwight Shilling, a three-time United States 
F3C world qualifier and currently ranked third in the United States in F3C, heli 
maneuvers will serve as your instructor for the helicopter instructions. 

When you select this item, the following dialog will appear: 

 

 

Select the maneuver that you wish to learn, and then click OK. RealFlight G2 Lite 
will show you a recording of an aircraft, piloted by the instructor (Mike or Dwight), 
performing the maneuver. During the maneuver you’ll hear the instructor’s voice 
instructing you how to do the maneuver. You can simultaneously watch the 
instructor’s stick movements on the onscreen radio gadget.  Best of all, you can even 
fly your own aircraft alongside the instructor’s!   

When you are done, you can end the instruction by closing the Playback Gadget. 

 

MMUUSSIICC//SSOOUUNNDD  
Music and sound effects add another dimension to your simulation experience.  You 
can choose to fly to background music or you can listen to the ambient sounds of a 
local flying field.  If you want some random “jeering,” then turn on the random 
effects.  If you have a slow sound card or a slow machine, you may not be able to 
turn “on” all of the sound effect options. 
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PLAY ENGINE SOUNDS 

Select whether or not to play the engine sounds.  Engine sounds are an important part 
of the simulation; they give you an audible indication of aircraft speed and distance.   

You will appreciate the Doppler- correct engine sounds as your aircraft goes 
screaming by you! 

ENGINE SOUNDS VOLUME SLIDER 

Use this slider to adjust the sound levels of the engines in the simulation.   

USE VIRTUALREVOLUTION TECHNOLOGY 

VirtualRevolution engine technology makes the engine sound correct at both idle and 
full power and everywhere in between.  This sounds the best, but can require more 
memory and will slow down the frame rate on slower computers.   

PLAY BACKGROUND MUSIC 

Select whether or not to play the CD-quality background music.  This can slow down 
the rendering speed.  Use this option only if you have a fast computer. 

MUSIC VOLUME SLIDER 

This slider is used to adjust the sound levels of the background music in the 
simulation.   



R/C Simulator RealFlight Chapter 8.  The Options Menu    57 

PLAY LIST 

Select which songs and ambient background tracks to play.  Highlight songs on the 
play list to turn them “on”.   

RANDOM EFFECTS SLIDER 

This slider displays the frequency of the "random" sound effects.  Adjust the slider to 
make them occur as in/frequently as you would like.  

RANDOM EFFECTS VOLUME SLIDER 

This slider displays the volume of the Random Effects.   

PLAY CRASH SOUNDS 

Select whether or not to play the crash sounds when the aircraft crashes. 

PLAY DIALOG SOUND EFFECTS 

Select whether or not to play the sound effects while navigating the dialogs. 

PLAY WIND SOUNDS 

Select whether or not to play the wind sounds when wind is enabled. 

USE SOFTWARE MIXING 

This box indicates whether to use the CPU or the Sound Card to mix the audio.  By 
turning on Software Mixing, you force the CPU to do the mixing which may be a 
little slower, but also might sound a little better. 
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    CCHHAAPPTTEERR  99..    TTHHEE  VVIIEEWW  MMEENNUU  

VVIIEEWW  MMEENNUU  OOVVEERRVVIIEEWW  
The View menu controls all options and settings for views. In this manual, we use the 
word “View” to describe two things: what you are looking at, and where you are 
looking from.  

To create or modify views, access the View menu. When you open the pull-down 
menu, you will see the following items: 

 

 

 

 

 Binocular View 

 Zoom Reset 

 Zoom In 
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 Zoom Out 

 Pilot at Fixed Position 

 Pilot in Aircraft 

 Pilot Behind Aircraft 

 Look at My Aircraft 

 Look at Wind Sock 

 Look at Ground 

 Quick Look 

 Gadget 

 Pilot and Viewport Options… 

BBIINNOOCCUULLAARR  VVIIEEWW  
The Binocular View option will show a perfectly zoomed aircraft.  You will see the 
aircraft as if you were looking through a pair of binoculars.  In Binocular View, the 
background of the viewport box becomes transparent.   This is a visual indicator so 
that you are aware that this viewport is using “binocular vision”. 

Binocular View is a great way to see the control surfaces on an aircraft that is too far 
away to see in the Main View.  Although not realistic, it does help to see the control 
input.   

 

ZZOOOOMM  RREESSEETT        
This selection resets the zoom magnification level.  This is useful if you are zoomed 
way in or way out and want to return quickly to the default level of magnification 
(set in Pilot and Viewport Options).  To set this, select Pilot and Viewport 
Options from the View menu.  Set the value using minimum aircraft size in the 
Auto Zoom section.   

You can also reset the zoom level by pressing F1.  

ZZOOOOMM  IINN  
This selection will zoom in on the aircraft.  Alternatively, the F2 key has the same 
effect.  RealFlight G2 Lite will incrementally zoom in on the aircraft each time the 
function key: F2 is pressed or Zoom In is selected. 

ZZOOOOMM  OOUUTT  
This selection will zoom out from the aircraft incrementally.  Alternatively, each 
time the F3 key is pressed the program will zoom out, incrementally, from the 
aircraft, thus giving a larger perspective of the area surrounding your airplane or 
helicopter. 
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PPIILLOOTT  AATT  FFIIXXEEDD  PPOOSSIITTIIOONN  
This selection will bring up all of the available options for the pilot at the fixed 
position. There are a number of available selections:  

 Set to Pit Area 

 Set to Current Aircraft Position 

 Set with Overhead View 

 Set to Last Fixed Position 

 Set with Mouse 

 Set Current position as Pit Area 

 Named Positions 

SET TO PIT AREA 
This selection will return the viewpoint to the default position for RealFlight G2 
Lite.  The default position is the pit area.  Alternatively, you may also press the F4 
key to Set to Pit Area as well. 

If however, you wish to change the location of the pit area, choose the Set Current 
Position as Pit Area selection. 

SET TO CURRENT AIRCRAFT POSITION 
This selection will move your vantage point to the current aircraft position.  The 
aircraft will continue its flight, however, your viewpoint will remain fixed at the 
place the aircraft was located at the moment you selected the Set to Current 
Aircraft Position option. 

If you would like your vantage point to follow along with the aircraft, select the Pilot 
in Aircraft view or Pilot Behind Aircraft view (see “Pilot in Aircraft” on page 62, 
or “Pilot Behind Aircraft” on page 63). 

Alternatively, you can press the F11 key to Set to Current Aircraft Position. 

SET WITH OVERHEAD VIEW 
When you select this option, RealFlight G2 Lite will bring up an overhead view of 
the flying site.  Move the mouse pointer to the desired vantage point and click.  This 
will set your vantage point.   

Alternatively, you can use the F7 key to Set with Overhead View. 

SET TO LAST FIXED POSITION 
This selection will undo the most recent vantage point modification. In other words, 
RealFlight G2 Lite will reset your viewpoint to its previous position.   
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SET WITH MOUSE 
This selection allows you to fully adjust the vantage point using your mouse.  You 
may also press the function: F8 key to do so.  

After selecting this option, or pressing F8, you may move the mouse forward and 
backward to move towards or away, respectively, from your aircraft.  Moving the 
mouse left or right will cause the viewpoint to circle around the aircraft.  You may 
also adjust the viewpoint up or down using the wheel on the mouse. If your mouse 
doesn’t have a wheel, simply hold down the right mouse button while you move the 
mouse forward and back. 

When you are satisfied with your vantage point, click the button to “lock” this 
position. 

SET CURRENT POSITION AS PIT AREA 
Select this option to set the current position as the pit area.  The pit area is the default 
viewpoint position.   

NAMED POSITIONS 
RealFlight G2 Lite lets you store vantage points for future use.  Select this option to 
store a position, or to bring up a list of the stored positions.  The stored positions are 
only available for the flying sites in which they were stored.  In other words, the list 
of Named Positions is unique for each flying site. 

NAMED POSITIONS 

This indicates any positions that are stored for the currently selected flying site.   

SAVE NEW POSITION 

Click this button to save the new position.  This will bring up the New Name dialog 
box.  Insert a name for the position in this box. 

MODIFY POSITION 

Saves the position to an already named position. 

DELETE POSITION  

This button will delete the selected position from the list of named positions. 

PPIILLOOTT  IINN  AAIIRRCCRRAAFFTT  
Select this item to place the vantage point inside the aircraft, as if you are actually 
piloting the aircraft.   

Alternatively, you can set Pilot in Aircraft by pressing the function: F5 key. 
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PPIILLOOTT  BBEEHHIINNDD  AAIIRRCCRRAAFFTT  
Select this option to bring up the chase view.  This viewpoint will always remain 
behind the aircraft being flown.   

Alternatively, you can set Pilot Behind Aircraft by pressing the function: F6 key. 

LLOOOOKK  AATT  MMYY  AAIIRRCCRRAAFFTT    
Select this option to look at the aircraft that you are piloting.  Alternatively, you may 
press the function: F9 key as well. 

LLOOOOKK  AATT  WWIINNDD  SSOOCCKK  
Select this option to look at the windsock, if applicable.  Please note: this selection 
will not have any effect if a windsock is not present at the flying site. 

LLOOOOKK  AATT  GGRROOUUNNDD  
Select this option to look at the ground beneath the viewpoint option.   This selection 
will always retain the ground in the vantage point.  This is helpful in altitude 
orientation. 

LLOOOOKK  AATT  LLOOCCAATTIIOONN  
Select this option to look at a specific location.  Alternatively, you may press the 
function: F10 key as well.  When selected, move the mouse to choose the location 
that you wish to view.  Once you are satisfied with the location, click on the mouse 
to set this position.  We find that this option is quite useful in locating the runway.  It 
assists in the orientation for landing approaches.  We suggest that you open a 
viewport and select the runway as the location. 

QQUUIICCKK  LLOOOOKK  
Select this option to quickly glance at either the ground or the windsock (if 
applicable). 

This option will momentarily look at the selected item and then return to the vantage 
point selected for the active viewport.  

GGAADDGGEETT  
Select this option to bring up the Gadget options and to choose the NavGuides. 

 

Gadget Preview 
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NavGuides™ shows you some 
basic information about your 
aircraft. See “NavGuides™ 
Gadget” on page 64. 

 

 

NAVGUIDES™ GADGET 
This Gadget allows you to view some basic information about your aircraft. 

 

 

FLIGHT PLAYBACK GADGET (ONLY AVAILABLE WITH THE VIRTUAL 

FLIGHT INSTRUCTOR) 
RealFlight G2 Lite’s highly versatile Flight Playback gadget lets you easily control 
playback of flight recordings using simple mouse clicks. It features VCR-like 
controls that start or pause the playback, and to speed up or slow down playback 
speed, etc. 

 

LOOP PLAY   

The arrows that form a circle are used to loop the recording (i.e., continuous play). 

LOOK AT RECORDING  

Click on the “eye” to start the playback.  Clicking on the “eye” will cause it to 
illuminate.  As long as the eye is illuminated, you will continue to view the current 
recording.   
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PAUSE  

The "II" button pauses playback if the recording is playing.  After you have paused, 
click this button once again to play the recording.  This button will be illuminated 
when the pause feature has been activated. 

POSITION OF RECORDING  

Use the slider control to choose the portion of the recording you wish to view. In 
other words, you can have the recording playback start in mid-recording, or end in 
mid-recording. Drag the lower arrow to set the playback start point, and the right 
arrow to set the playback end point. As you play the recording, the top arrow tracks 
to show you what playback time segment you are currently viewing. You can set to a 
different playback segment by dragging the top arrow. 

PLAYBACK SPEED  

The number on the far right side is the speed at which the playback will occur.  You 
can adjust the playback speed by clicking on the up/down arrows next to the number. 
To increase playback speed, click on the up arrow.  To reduce playback speed, click 
on the down arrow.  You can use this when you’re learning a maneuver from a 
recording—adjust the playback speed to watch the maneuver in slow motion. 

RADIO GADGET (ONLY AVAILABLE WITH THE VIRTUAL FLIGHT 

INSTRUCTOR)   
This transmitter offers a digital recreation of the transmitter onscreen.  This digital 
transmitter mimics the stick input in real-time.  This serves as a visual aid in the 
training process and an onscreen reminder for the proper stick inputs. 

 

 

PPIILLOOTT  AANNDD  VVIIEEWWPPOORRTT  OOPPTTIIOONNSS  
 

  

VIEWPORT PAGE 
These options are used to adjust a variety of features for the viewports.   
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. 

NO AUTO ZOOM 

Clicking this check box will disable the Auto Zoom features. 

MAKE AIRCRAFT LARGER 

Clicking this check box will make the aircraft appear larger at a distance of 100 
meters.  The size of the aircraft is determined in the dialog box to the right of the 
check box. 

ZOOM IN ON AIRCRAFT 

Clicking on this check box will cause the Auto Zoom feature to become active when 
the aircraft goes beyond a determined distance.  For more information, please see the 
“Distance at Which Auto Zoom Activates” below. 

DISTANCE AT WHICH AUTO ZOOM ACTIVATES 

This indicates the distance at which the Auto-Zoom feature will be activated.  If the 
aircraft is closer than the specified distance, the Auto-Zoom feature will not be 
disabled. 

MINIMUM AIRCRAFT SIZE 

This indicates the minimum aircraft size of the aircraft when using the Auto-Zoom 
feature.  To return an aircraft to this default size, press the function: F1 key. 
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    CCHHAAPPTTEERR  1100..    TTHHEE  HHEELLPP  MMEENNUU  

HHEELLPP  MMEENNUU  OOVVEERRVVIIEEWW  
Should you experience any difficulties (or just want to find out more about 
RealFlight G2 Lite and its features), the Help menu has several resources to assist 
you. When you open the pull-down menu, you will see several options:  

 

 Contents… 

 Technical Support… 

 Credits… 

 Slide Show… 

 Tip Of the Day 

 RealFlight on the Web 

 Online Updates… 

 Take Screen Shot 

 About… 
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CCOONNTTEENNTTSS  
This opens up RealFlight G2 Lite’s help files. The help files contain information 
similar to this manual. 

TTEECCHHNNIICCAALL  SSUUPPPPOORRTT  
If you should have any difficulties running RealFlight G2 Lite, consult this item. 
You can access online troubleshooting information, or contact RealFlight G2 Lite 
technical support. 

CCRREEDDIITTSS  
Select this item to see the names of some of the people who contributed to RealFlight 
G2 Lite. 

SSLLIIDDEE  SSHHOOWW  
Slide Show gives you a brief preview of many of RealFlight G2 Lite’s aircraft and 
airports using still images.  

TTIIPP  OOFF  TTHHEE  DDAAYY  
Tip of the Day is a sequence of helpful tips and hints about using RealFlight G2 Lite. 
You can set tips to appear each time you run RealFlight G2 Lite, or read all the tips 
in one sitting. Tip of the Day will introduce you to many great RealFlight G2 Lite 
features you may not have noticed. 

REALFLIGHT ON THE WEB REALFLIGHT WEB SITE 

This is the main web site for RealFlight G2 Lite. 

See it now: http://www.realflight.com 

GREAT PLANES WEB SITE 

This is the web site for Great Planes, the publishers of RealFlight G2 Lite 

See it now: http://www.greatplanes.com 

KNIFE EDGE SOFTWARE WEB SITE 

This is the web site for Knife Edge Software, the developers of RealFlight G2 Lite. 

See it now: http://www.knifeedge.com 
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CHAT WITH OTHER REALFLIGHT USERS 

Go here to chat with other RealFlight® users and to hook up for some great 
Multiplayer Action. 

See it now: http://www.knifeedge.com/chat.htm 

GP SOFTWARE SITE 

Visit this site for information about our software products, including RealFlight G2 
Lite. The site includes our online product Knowledge Base. This is the same 
problem-solving database our product support staff uses to help RealFlight® owners 
resolve problems. 

See it now: http://www.gpsoftware.com 

OONNLLIINNEE  UUPPDDAATTEESS  
This menu launches the RealFlight G2 Lite Control Panel.  See “Appendix B. 
RealFlight G2 Lite Control Panel” on page 83. 

SSCCRREEEENN  SSHHOOTT  
Create a screen shot of RealFlight G2 Lite’s current display.  

You can take more than one screen shot while you’re flying. The screen shot files are 
saved to c:\program files\realflight.  

When you start RealFlight G2 Lite, it will erase any previously saved screen shots 
(unless you move your old screen shots to a different directory).  
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AAPPPPEENNDDIIXX  AA..  FFLLYYIINNGG  TTHHEE  AAIIRRCCRRAAFFTT  

AAIIRRPPLLAANNEE  BBAASSIICCSS  

SWITCHES 
Before you fly the plane, make sure all the switches are in their “off” (or low rates) 
positions.    The switches may be assigned to different items depending on how you 
have configured your controller and which aircraft you are flying.  Check the 
description of the aircraft to determine the default switch settings.  If you are using 
your own transmitter to control RealFlight, please consult your transmitter owner’s 
manual for more information. 

CENTERING 
Trim tabs are the small slider controls on the controller (two per controller stick). 
They “trim” the aircraft so that it flies straight and level.  For example, if an airplane 
has a tendency to veer slightly downward, you may need to add a slight “up” nudge 
to the elevator. You can do this by sliding the elevator trim, a click or two at a time, 
towards the bottom of the controller. 

CCRRAASSHHIINNGG  
“While takeoffs are optional, landings are mandatory.” For any type of aircraft or 
flying, successfully landing an aircraft is a crucial skill to master.  

The key to a perfect landing is undivided concentration.  Pay close attention to the 
altitude of the aircraft as well as its orientation to the runway.  Use each crash as a 
learning experience to perfect your approach and the landing.  

RealFlight G2 Lite has several tools to help you stay on top of things during 
approach and landing.  See “Landings” below for some ideas. 
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AAIIRRPPLLAANNEE  FFLLIIGGHHTT  
RealFlight G2 Lite simulates how R/C aircraft really fly. This allows you to practice 
R/C flying without worrying about expensive crashes.  Additionally, RealFlight G2 
Lite is ideal for practicing new maneuvers and experimenting with various parameter 
adjustments.  It is important to remember, however, that a simulator will only help 
you learn to fly if you let it.  Otherwise, it is just a game.  Learning to fly R/C aircraft 
requires a commitment.  One doesn’t just grab the sticks and start dazzling the 
crowds.  A methodical, patient approach will help you get the most out of this 
simulator. 

This section is not designed to teach you how to fly. Rather, it will help you enhance 
your experience with the simulator.  

TAKEOFFS 
When you are taking off, start with the throttle in low position and slowly increase 
throttle by pushing the throttle stick away from you towards the top of the transmitter 
until you are at about half speed. Stay in the middle of the runway (you can steer the 
plane using the rudder).  When you have built up enough speed, you can climb off 
the runway by gradually pulling back on the elevator. If the plane is tracking well, 
apply the rest of the power more quickly, climbing out and gaining altitude.   

Be careful not to veer off the runway. In a real plane, chances are you would crash 
(or get stopped on the grass). Usually this means a bent landing gear and broken 
prop; if your plane has retracts, they could even get ripped out of the wing. 

LANDINGS 
It is very important to land on the runway, rather than veering off, or touching down 
before you reach the runway. Either of the latter usually produces a moderately 
expensive crash. If you “cartwheel” (wing tip hits the ground first), the wing can 
break, resulting in lengthy down time. 

Start by aligning your plane with the runway. Fly the approach normally, using your 
throttle to control the rate of descent. Try to land at the slowest speed possible. If 
your plane has flaps, use them to kill speed (but be careful; with flaps down your 
plane will try to pitch up and climb). If your plane has retractable landing gear, lower 
them, and as you touch down, keep your nose up! 

RealFlight G2 Lite has several tools to help you practice landings.  

 Before you try to land yourself, you may want to get a lesson from a 
pro. Under the Options menu, select Virtual Flight Instructor™; when 
a dialog appears, select the “Touch and Go” lesson.  

 As you land, use the NavGuides™ (View/Gadget menu item) to keep 
track of your speed, altitude, and distance above ground. 

 If you lose sight of the ground, you can orient yourself using the 
“Quick Look” feature. In the menus, select View/Quick 
Look/Ground. Your view will briefly pan from the plane to ground, 
then back to the plane. 

 You can also activate the Look At Ground feature. In the View menu, 
select Look at Ground. This option will cause the active view to 
always look toward the ground, regardless of aircraft location.    
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AEROBATICS 
When you practice aerobatics, the three important steps are: 

 Start the plane straight and level, in a controlled situation 

 Perform the maneuver 

 Get back into a straight, controlled situation 

Anyone can give it full throttle, jam the sticks in all directions and watch the plane 
tumble and roll.  But this is not what you will do out in the field. Do this and you 
won’t have control of the airplane! 

By getting set up properly, performing the maneuver, and then finishing, your 
experience will be more rewarding as well as more realistic. 

Concentrate on making the maneuvers “clean.”  If you are doing a roll, try to keep 
the plane on a straight line as you roll.  If you are doing a loop, try to make a 
perfectly round circle. 

THROTTLE MANAGEMENT 
Avoid the temptation of giving the plane full throttle and keeping it there for hours at 
a time. This teaches you bad habits and makes even a good flier look like a rookie 
out at the field. 

Many of the maneuvers require proper throttle management in order to make a 
maneuver look good.  Loops, stalls, torque rolls, touch-and-goes are just a few 
examples.  Try doing various maneuvers at differing speeds.  Try performing a slow 
roll at medium throttle and keeping a perfectly straight line.  This is very hard and 
will earn you more praise at the field than doing a full speed, full stick roll. 

RUDDER MANAGEMENT 
Planes can, more or less, effectively be flown with just the elevator and ailerons.  
But, good pilots will tell you that rudder is just as important.  Many aerobatic 
maneuvers require excellent rudder usage. 

Rudder control is especially important when landing in a crosswind.  Pilots that 
cannot use the rudder usually land in the tall grass (embarrassing!).  Pilots that do 
use the rudder can land on the numbers almost every time. 

TAKE CRASHES SERIOUSLY 
Out at the field a crash might result in one or more of the following: 

 Bruise your ego 

 End flying for the day 

 Cost you money 

 Cost you time to rebuild 

 Even win you a nice “best crash trophy!” 

Of course, when you crash on the simulator, there is really no harm done.  None, that 
is, except the bad habits you can learn. Take the crashes seriously.  Learn from each 
one and you will be a better pilot out at the field. 
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HHEELLIICCOOPPTTEERR  BBAASSIICCSS  
 

A model helicopter is a very complicated machine, which operates on the same 
aerodynamic principles as its full-scale counterpart. These principles are quite 
complicated to explain and understand.  However, it is not necessary to understand 
all the underlying aerodynamics in order to successfully fly a model helicopter (or a 
computer simulation).  

The following will help you to better understand the basics of helicopter flight, and 
the relationship between control stick movements and the actions of the machine. 
Refer to these instructions often as you become more proficient. 

Note: The inputs below are shown using a Mode 2 transmitter. 

COLLECTIVE (LEFT STICK - VERTICAL MOVEMENT) 
The helicopter is lifted into the air by the spinning rotor blades, which act like 
rotating wings. Changing the pitch (angle of attack) and speed of the blades, using 
the “collective” and throttle controls the vertical rise and descent of the helicopter. 
Adjusting “collective” increases and decreases the blade pitch.  The “throttle” 
control increases and decreases engine RPM. On a model helicopter, the collective 
and throttle controls are mixed electronically, and controlled by the throttle stick on 
the transmitter or controller.  

 



R/C Simulator RealFlight Appendix A. Flying the Aircraft    77 

 

RUDDER (LEFT STICK - HORIZONTAL MOVEMENT) 
To turn the nose of the helicopter left or right, change the tail rotor pitch (by using 
the “rudder” control). Changes in collective stick movement will require changes in 
the amount of rudder input to maintain heading. 
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CYCLIC STICK (RIGHT STICK) 
The cyclic stick replaces the “aileron” and “elevator” controls found on a fixed-wing 
aircraft. “Cyclic” is the term given to the control of the main rotor that allows the 
helicopter to fly forward, backward, left and right. Forward cyclic stick movement 
causes the helicopter to pitch forward, left cyclic cause the helicopter to tilt sideways 
to the left, on so on. You move the helicopter forward or sideways using a 
coordinated movement of both the cyclic and collective control sticks. Moving the 
cyclic stick to the right, while simultaneously increasing collective, will cause the 
heli to move sideways to the right. “Rudder” control is used to maintain heading. 
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IDLE-UP 
A switch on the controller actuates a special function, known as “idle-up.”   Idle-up 
offers an alternate throttle and pitch curve, different from the curves used for 
hovering.  Idle-up is usually used for aerobatics, when the pilot wants engine power 
added when pitch is subtracted. (For example, inverted hovering positive throttle and 
negative pitch, so pulling the collective stick back provides positive throttle AND 
increased pitch together). 

THROTTLE HOLD 
Another special function is known as the “throttle hold”. When activated, this switch 
sets your throttle to idle but allows the collective to function normally. This allows 
you to practice auto-rotations without shutting the engine off. 

GYRO 
Any sudden change to the torque of the main rotor, such as a quick change in RPM 
or a wind gust, can cause the helicopter to turn unintentionally to an unwanted 
direction. An electronic device known as a gyroscope (gyro) is used to “monitor” 
and correct for this by giving commands to the rudder control to help stabilize the 
machine. 

Gyros come in a variety of types, each with different features. A normal gyro will 
not return the heli to its former heading; it will only stop the unwanted sudden 
movement.   

 

HHEELLIICCOOPPTTEERR  FFLLIIGGHHTT  

HOVERING 
The machine hovers by adjusting the collective control to maintain altitude, the 
rudder to maintain heading, and minute adjustments to the cyclic controls to maintain 
location. Hovering is the most important aspect of heli flight to master, since every 
other movement of the machine starts and stops with a hover. 

FORWARD FLIGHT 
The heli moves forward by increasing cyclic (moving the cyclic control forward). 
This causes the helicopter to tilt forward, resulting in a forward thrust. As the cyclic 
increases, the collective must also be increased to maintain the desired flight path.  
As forward speed increases, the collective can be reduced slightly. 

BACKWARD FLIGHT 
Backward flight is accomplished by moving the cyclic control aft, which causes the 
helicopter to tilt backward. As the cyclic is moved aft, the collective must also be 
increased to maintain desired flight path. As backward speed increase, the collective 
can be reduced slightly. 
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SIDEWAYS FLIGHT 
Moving the cyclic control left will cause the helicopter to tilt left. Add collective and 
right rudder to cause the heli to “slide” sideways to the left. As speed increases, it 
will require progressively more rudder to maintain heading.  

To move right, simply follow the same procedure, but reverse the cyclic and rudder 
movements (move cyclic right, apply left rudder). 

TURNING: 

FROM FORWARD FLIGHT- 

Moving the cyclic control left, while applying a small amount of aft cyclic and 
feeding in left “rudder”, will cause the helicopter to make a coordinated turn to the 
left. Right movement of the cyclic and rudder sticks will cause the heli to turn to the 
right. 

 

FROM A HOVER- 

Use the rudder to rotate the nose of the heli in the direction you want. 
 

Learning to fly a model helicopter is more difficult and challenging than any other 
radio control models, but is also the most rewarding as you master the techniques 
required for sustained hover and forward flight. Computer simulation of model 
helicopter flight is an excellent tool for learning the basics and dramatically reducing 
the learning curve when you move on to the actual model itself. 
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AAPPPPEENNDDIIXX  BB..  RREEAALLFFLLIIGGHHTT  GG22  LLIITTEE  

CCOONNTTRROOLL  PPAANNEELL  

RREEAALLFFLLIIGGHHTT  GG22  LLIITTEE  CCOONNTTRROOLL  PPAANNEELL  
The RealFlight G2 Lite Control Panel is a separate application that is designed to 
work in conjunction with RealFlight G2 Lite. 
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RUNNING THE CONTROL PANEL 
There are three ways to run the RealFlight G2 Lite Control Panel. 

 Insert the CD into the drive.  If Auto-Play is active, then the RealFlight 
G2 Lite Control Panel will start on its own. 

 If RealFlight G2 Lite is already installed, click the “Start” button in the 
Windows Task Bar. In the Start menu, select 
Programs/RealFlight/Control Panel. 

 If RealFlight G2 Lite is already running, choose Online Updates… 
from the Help menu. 

RUNNING REALFLIGHT LITE 
To start running RealFlight G2 Lite, press the Run RealFlight G2 Lite button on the 
Control Panel.  (Note: if RealFlight G2 Lite is already running, the Control Panel 
will not let you start up a second RealFlight G2 Lite window.) 

UNINSTALLING REALFLIGHT LITE 
To Uninstall RealFlight G2 Lite, press the Uninstall Program Button.  The 
following dialog will appear: 

 

 

We suggest that you use this method, not the “Add/Remove Programs” feature in 
Windows, to uninstall RealFlight G2 Lite.  Doing so through the RealFlight G2 Lite 
control panel will ensure that all necessary RealFlight G2 Lite files are removed. 

UNINSTALL PROGRAM 

Choose this option to uninstall only the RealFlight G2 Lite program itself.   

UNINSTALL DATA FILES 

Choose this option to uninstall any user files such as your created airports, 
customized aircraft, color schemes, songs etc.  Be careful with this option! You 
could lose a lot of your work by inadvertently uninstalling these files. 

REMOVE SERIAL NUMBERS 

Choose this option to remove all RealFlight G2 Lite serial numbers from your 
system. 
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REMOVE CACHED FILES 

Choose this to option to remove all cached download files from your system.  If you 
uninstall these files, future downloads may take a little longer. 

 

READ HELP FILE 
Press the Read Help File button to bring up the help file for RealFlight G2 Lite. 

 

TECHNICAL SUPPORT 
Press the Technical Support button to bring up technical support information about 
your system.  If you encounter any problems with RealFlight G2 Lite, this 
information can help you to resolve it on your own, or can help Great Planes’ 
Support Staff to diagnose the problem. 

 

SYSTEM INFORMATION 

This displays a list of the critical system information.  Before you email technical 
support, or report a bug with the software, please be sure to cut and paste this 
information into your email. This will be of great assistance to them in diagnosing 
the difficulty.  

DX EXAMPLES 

Press these buttons to run example DirectX programs written by Microsoft®. They 
are very basic programs that test your DirectX installation and hardware.  If these 
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samples don’t run correctly, then your problem lies either with your DirectX 
installation or with your hardware drivers (usually video or sound).   

To resolve these problems you should first contact your video/sound card 
manufacture for updated drivers. This is very important. Card manufacturers 
frequently update their drivers to fix problems that arise when used with programs 
like RealFlight G2 Lite. Even if you just bought a new computer system there may 
be a new, updated driver available for download. 

If you are sure you have the latest drivers, you may need to reinstall DirectX, or 
update your version. 

REINSTALL DIRECTX 

Choose this option to reinstall DirectX.  Occasionally this will fix corrupted 
installations. 

ASSEMBLE SYSTEM INFORMATION 

Choose this option to collect critical information about your system, and about your 
RealFlight G2 Lite settings. You may find this information useful if you try to 
troubleshoot problems on your own. Moreover, if needed you can cut and paste this 
information into an email to Great Planes Technical Support. When you use the 
online registration to register RealFlight G2 Lite, this is the hardware information 
that is sent to Great Planes. 

 

ENTER TECHNICAL SUPPORT CODE 

Choose this option to enter a technical support code. If you do encounter problems 
running RealFlight G2 Lite, our Technical Support team may supply you with a code 
to input here. Entering this code will help them diagnose or resolve your problem.  
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VIEW WEB TECHNICAL SUPPORT 

Choosing this option will open a browser window, and take you to a web site that 
contains the most up-to-date technical support information for RealFlight G2 Lite. 

EMAIL TECHNICAL SUPPORT 

This gives you the email address rfsupport@greatplanes.com to which you can 
email your problems.  If you do email us, please be sure to attach the Assemble 
System Information output to your email. 

VIEW TASKS 

This shows you a list of all tasks that are running.  Some tasks can interfere with 
RealFlight G2 Lite and may need to be closed.  Our Technical Support team will be 
glad to help you close problem tasks. 

DX DIAGNOSTICS 

This brings up Microsoft’s DXDIAG utility.  Using this utility can further help 
diagnose your system. (Important: if you send us information about your system to 
help us diagnose a problem, please do not use DXDIAG to generate that information. 
Instead, please use the Assemble System Information feature [see above]. The 
Assemble System Information output file contains more information than the 
DXDIAG output.) 
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MSINFO 

This option will run MSInfo.  This will give you even more information about your 
system. This program is not always installed on your computer, but normally comes 
with programs such as Microsoft Office®. 

 

DISPLAY PROPERTIES 

This brings up your monitor’s display properties. You can use this page to change 
the resolution of your desktop. 

 

EXPLORER 

This button launches Windows Explorer. This Microsoft Windows® utility can help 
you locate, move and backup your files. 
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LAUNCH DEVICE MANAGER 

This button launches the Device Manager. This Microsoft Windows® utility will 
help you determine driver dates, as well as installing and updating video and sound 
card drivers. 
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VIEWING DOCUMENTS 
This lets you view important documents that come with RealFlight G2 Lite. 

OONNLLIINNEE  UUPPDDAATTEESS  
We are proud to bring you a cutting edge way to keep your RealFlight G2 Lite 
program updated to the latest version.  Gone are the days of self-extracting EXEs, 
lost files, or cumbersome web sites.  Just a single button click will download the 
latest version and install it correctly. 

 

REGISTRATION 
The first thing you must do before you can use any of the online functions is to 
register the program with Great Planes. 
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Please enter in all the correct registration.  If you forget your password, contact Great 
Planes Support.  To do so, email them at rfsupport@greatplanes.com or telephone 
them at 217-398-8970 (option #1).  They will confirm your identity, and issue you a 
new password. 

HARDWARE INFORMATION 

RealFlight G2 Lite offers you the option of automatically sending us information 
pertaining to your system hardware and settings when you register. It will do so if 
you leave the Send Hardware Information box checked when you register.  

This information will assist us more rapidly in diagnosing any problems you may 
encounter later, should you need to contact Technical Support. Consequently, we 
suggest that you leave this box checked when registering. 

This feature is entirely optional. If you uncheck the box, RealFlight G2 Lite will not 
send us any information about your system. Or, you can view exactly what 
information RealFlight G2 Lite will send us before you decide. To view this 
information, click the Technical Support button on the RealFlight G2 Lite Control 
Panel. When the Technical Support page appears, click Assemble System 
Information. 

UPDATING TO THE LATEST VERSION 
After registering (you only need to register once), you can update to the latest 
version.  This will download all necessary files and correctly install the upgrade. 
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CHECK FOR LATEST UPDATES BEFORE RUNNING REALFLIGHT G2 LITE 

If you check this box, then every time you run the RealFlight G2 Lite Control Panel, 
the panel will check to see if there is a newer version of RealFlight G2 Lite available.  
If so, the Control Panel will then ask you if you want to download and install it.  
Note: Your PC must be connected to the Internet in order to do so. 

ADVANCED OPTIONS 

UPDATE TO SPECIFIC VERSION 

If you are having problems with a version you just downloaded, you can actually go 
backwards and retrieve a previous version.  If the previous version fixes your 
problem, please contact our technical support team at rfsupport@greatplanes.com 
and let them know about the problem encountered. 

 

CLEAR DOWNLOAD CACHE 

Some times files can become corrupted on download.  If you are having problems 
with the Online Upgrades, try removing all cached files using this option, then 
choosing Update to Specific Version and select the Completely Refresh option. 
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PROXY SETTINGS 

 

If you are behind a firewall that restricts FTP access, you may need to change the 
proxy settings in order for RealFlight G2 Lite to get the latest updates. Most home 
users will keep the Proxy Server OFF. 

If you do need to use the proxy server, contact your network administrator to 
determine which settings to use. 

PROBLEMS UPDATING? 
Here are some possible problems that might occur when updating. 

BAD INTERNET CONNECTION 

 

You either don’t have access to the Internet (You can double check this with your 
browser), or the FTP server is unavailable.  Try reaching the Internet with your 
browser.  If you are behind a proxy server, then adjust the proxy settings. 

SERVER UNAVAILABLE 

 

The server may be down or may be overloaded.  Please try again later.  If this 
problem persists, contact technical support and explain your problem. 
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AAPPPPEENNDDIIXX  CC..  IIFF  YYOOUU  EEXXPPEERRIIEENNCCEE  

DDIIFFFFIICCUULLTTIIEESS  WWIITTHH  RREEAALLFFLLIIGGHHTT  GG22  

LLIITTEE……  

IINN  GGEENNEERRAALL  
This simulator is on the cutting edge of technology, and runs using advanced 
hardware.  Consequently, there is always the possibility you may experience some 
difficulties. Should the need arise, we provide extensive resources to help. 

Besides providing the best R/C simulator, we sincerely feel that we provide the best, 
most extensive product support for any R/C simulator. Since cards, drivers, operating 
systems, etc. are always changing, we work hard to keep our support up to date on 
the latest issues and problems RealFlight G2 Lite users might encounter. 

This section starts with a summary of the various sources of RealFlight G2 Lite 
information, support, and problem solving help that you can access. Then, we’ll 
show you some simple but powerful steps that can resolve or prevent most 
RealFlight G2 Lite problems. Finally, if these steps don’t solve your problem, we’ll 
show you the most effective ways to acquire additional assistance. 

HOW TO GET HELP AND INFORMATION 
As a RealFlight G2 Lite user, you have access to an incredible amount of 
information about this product. Much of this information can help you resolve 
problems, or correctly access and use program features. Here’s where you can find it: 

 The manual. You can solve most common RealFlight G2 Lite 
problems by following the instructions in later sections of this chapter. 
Additionally, other manual chapters explain RealFlight G2 Lite’s 
features in greater detail.  

 Online Help. You can access all of this manual’s material directly 
from RealFlight G2 Lite’s Help menu. This help file is indexed and 
searchable. 

 Visit our product Knowledge Base at http://www.gpsoftware.com. 
This great resource is an indexed, searchable collection of articles that 
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described solutions to almost every known problem with RealFlight G2 
Lite, RealRace®, and all our other software products. This is the very 
same information database that our product support technicians refer to 
when assisting customers.  

 Visit the Knife Edge Software Message Boards at 
http://www.knifeedge.infopop.net. This is a place where owners of 
RealFlight, RealFlight G2, RealFlight G2 Lite, RealRace, and other 
Knife Edge products post questions, comments and responses. 
Sometimes our product support technicians, and product developers 
from Knife Edge, post replies and announcements as well. You may 
find a thread that discusses the same difficulties that you are 
experiencing.  

 Contact our Product Support department by email at 
mailto:rfsupport@greatplanes.com, by phone or postal mail at: 

RealFlight Product Support 
1610 Interstate Drive 
Champaign, IL 61822 
Voice phone: (217) 398-8970 
FAX phone:  (217) 398-7721 

They are specially trained, and have a lot of resources, to help you 
resolve problems with RealFlight G2 Lite. 

 Visit the home page of Knife Edge Software, the makers of RealFlight, 
RealFlight G2 Lite, RealRace and other R/C simulation products, at 
http://www.knifeedge.com. On this page, you can link to the Knife 
Edge Chat Room, where you can chat live with other RealFlight or 
RealRace users. Sometimes product developers from Knife Edge hang 
out here as well. (Please note, however, that due to time, staffing and 
other constraints we usually cannot provide problem troubleshooting 
assistance in the chat room.) 

 

BEFORE YOU DO ANYTHING ELSE… 
  

If you are experiencing any difficulties with RealFlight G2 Lite, you should always 
try the steps below first. These steps really do cure most problems our users 
experience. Even if you aren’t having a problem, these same steps often help make 
RealFlight G2 Lite, and your computer, work better. 

Here are the steps you should take (instructions for each step follow): 

 Update your video and sound card drivers (see instructions below).  

 Update to the latest version of RealFlight G2 Lite. 

 If the problem persists, run the DirectX test programs. 

 If these steps don’t work, read on to the next section. 

Update Your Drivers 

Before you do anything else, you should make sure you have updated your video and 
sound drivers. A large number of problems encountered by RealFlight G2 Lite users 
can be cured by updating drivers. 
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A driver is a software program that controls your video or sound card. Each card 
manufacturer provides drivers for its own cards. To work correctly, RealFlight G2 
Lite relies on your video and sound card drivers.  

It is very important to use the latest available driver for your card. Card 
manufacturers frequently release updated drivers to fix problems that occur when the 
driver is used with programs such as RealFlight G2 Lite. The driver that came with 
your new computer, or on your Windows CD, or on a CD included with the new card 
you bought, may not be the latest version. 

If you don’t know how to update drivers, you can find instructions in our Knowledge 
Base article Q01-1038, How to Update Drivers, at 
http://www.gpsoftware.com/kb/q01-1038.htm. This page will take you through the 
process step-by-step, and has links to driver download sites for most manufacturers. 

Update to the Latest Version of RealFlight G2 Lite 

As we regularly release program updates, the difficulty that you are seeing may 
already be fixed in an update. Even if you just bought RealFlight G2 Lite, you should 
update to the latest version.  

To update, use the  control panel (see Appendix B. RealFlight G2 Lite Control Panel 
on page 83. 

Run the DirectX Test Programs 

If you have updated your drivers and RealFlight® Lite to the latest versions, and 
your problem persists, you should try to run the DirectX samples that come with 
RealFlight® Lite. 

The DirectX samples (Billboard, Sound, etc.) are test programs written by 
Microsoft. These samples ship with DirectX, and are designed to check whether your 
DirectX installation, video/sound cards and drivers, etc., are working correctly. They 
should work on any DirectX 8 compliant driver. 

You can run the samples using the RealFlight® Lite Control Panel. Open the Control 
Panel, click “Technical Support,” and then look for the “DX Examples” box. Click 
a button to run a sample program. 

The most important sample is Billboard, which tests your video card and driver. If 
you are having any graphics difficulty in RealFlight® Lite (including RealFlight® 
Lite “freezing” your system so that you have to reboot), look for the same problem in 
Billboard. If the problem occurs only after you have run RealFlight® Lite for a long 
time, make sure to run Billboard for a comparable length of time. 

If your RealFlight® Lite problem also occurs in Billboard, the problem lies with 
your video driver, not RealFlight® Lite. To resolve the problem, try finding updated 
drivers for your card (see above). If the problem still occurs with the latest drivers, 
you will need to report this problem to the card manufacturer. Be sure to tell them 
that you tested the card by using Billboard. Please note: in rare cases, a newer video 
driver may have more problems than a previous version. After exhausting all other 
options, you might try obtaining an older driver from the manufacturer to eliminate 
this possible cause as well. 

If These Steps Don’t Work… 

If the steps above don’t work, please read on to the next section. 
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IF YOU NEED ADDITIONAL ASSISTANCE… 
You’ve updated drivers, updated RealFlight® Lite, and your system successfully 
runs the DirectX sample programs, and you are still having problems. What next? 

As a first step, we suggest checking our knowledge base at 
http://www.gpsoftware.com. This is an easy to use, searchable, browsable database 
of known problems and solutions for RealFlight®, RealFlight® Lite, RealRace®, 
and our other software products. This is the same database that our Product Support 
technicians use when helping customers. So, we are constantly updating the 
knowledge base to address new problems as we discover them. In many cases you 
will be able to find an article that gives clear, concise instructions for resolving your 
difficulty. 

You may also want to check the Knife Edge Message Boards at 
http://www.knifeedge.infopop.net. This is a place where owners of RealFlight®, 
RealFlight® Lite, RealRace®, and other Knife Edge products post questions, 
comments and responses about problems. You may find a discussion thread about 
the problem you are experiencing. 

You can also contact Product Support at Great Planes via email at: 
rfsupport@greatplanes.com   

IMPORTANT. If you do contact Product Support, you can help us enormously by 
providing detailed information about your computer system. Since your problem 
may only occur on a particular video or sound card, particular driver version, etc., we 
may need this information to help us diagnose your problem. To get your system 
information, use the RealFlight® Lite Control Panel (from RealFlight® Lite, select 
“Online Updates” from the Help menu).  In the control panel, click the Technical 
Support button, followed by the Assemble System Information button. This will 
create a file called “c:\cpaneloutput.txt”, which contains your system information. 
You can attach this file to an email. 

 

EEXXAAMMPPLLEESS  OOFF  CCOOMMMMOONN  PPRROOBBLLEEMMSS  AANNDD  SSOOLLUUTTIIOONNSS  
 

IF YOU DON’T SEE YOUR PROBLEM IN THIS CHAPTER… 
This chapter contains a few examples of common problems and concerns that 
RealFlight® Lite users have experienced.  

Remember that we can never provide a complete list of problems and solutions in a 
program manual. That’s because RealFlight® Lite --and the computers, cards and 
drivers it uses--are constantly evolving. As such, we maintain a detailed Knowledge 
Base at http://www.gpsoftware.com. By keeping our Knowledge Base online, we can 
provide you with the latest information about resolving problems that RealFlight® 
Lite users are currently experiencing. So, if you don’t see your difficulty described in 
this chapter, please check the Knowledge Base. 

In this chapter, we’ve simply tried to pick a very short list of the most asked about 
issues. 
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MY COMPUTER “FREEZES” WHEN I RUN REALFLIGHT G2 LITE, AND I 
NEED TO REBOOT TO REGAIN CONTROL. 

Sometimes, you may also notice sound skipping or repeating, or a computer reboot 
while flying. To resolve this type of problem, you must update the drivers for your 
video and sound cards. This is very important. Card manufacturers regularly update 
their drivers to fix this type of problem. Even the driver that came with your new 
computer may not be the most recent. 

Sometimes a card manufacturer will offer a choice between a “recommended” 
driver, and another driver (variously called “special purpose”, “alternate”, or “beta” 
driver). If RealFlight® Lite “freezes” with the “recommended” driver, try using the 
alternate driver instead. 

If you are sure you are using the latest drivers, and have followed all the other steps 
in the previous section (update RealFlight® Lite, test DirectX) and are still having 
difficulty with your computer locking up while running RealFlight® Lite, please 
contact Great Planes Technical Support. 

IMPROVING REALFLIGHT® LITE PERFORMANCE 
During installation, RealFlight® Lite analyzes your computer’s hardware 
specifications. RealFlight® Lite then tries to optimize its configuration to best take 
advantage of that hardware, and achieve the best possible performance. 

However, if the performance is less than you’d expect, you can adjust some of 
RealFlight® Lite’s settings to improve the simulation speed and frame rate: 

 Ensure that the drivers for the video and sound cards are up-to-date.  

 Turn off all other programs, especially virus checkers and network 
applications (such as Instant Messengers) while running RealFlight® 
Lite.  Use CTRL-ALT-DELETE to ensure that nothing else is running 
in the background.   

 Run the simulation in Full Screen Mode (in the Options menu, 
uncheck the Run in Window option). Alternatively, if you are running 
in Window Mode (Run in Window option is checked), alter the screen 
resolution from 32-bit to 16-bit color.  Also, decrease the size of the 
RealFlight® Lite window. 

 Reduce the texture quality.  This can have a profound effect on cards 
that do not have a high texture memory.  You can adjust texture quality 
on the Graphics Optimization page (See “Graphics Optimizations” on 
page 51 )  

 Use PhotoField rather than the 3D Terrain option. In the Airport menu, 
uncheck the 3D Terrains item (if the item is not checked, you are 
already using Photofield). Or, if you don’t want to use Photofield, 
decrease the terrain density using the Graphics Optimizations page 
(See “Graphics Optimizations” on page 51 )  

 Eliminate the Airport Objects Shadow using the Graphics 
Optimizations page (See “Graphics Optimizations” on page 51 )  

 Eliminate the Detail Textures using the Graphics Optimizations page 
(See “Graphics Optimizations” on page 51 )  

 Reduce the number of open Gadgets.   
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 Eliminate the Smoke/Exhaust options.  Press the”`” (Accent) key on the 
keyboard. 

 Disable the trees.  In the Airport menu, uncheck the Show Trees 
option (this will make all trees and foliage disappear from your flying 
field). (See “Show Trees” on page 37) 

 Eliminate collisions.  Uncheck Enable Collisions in the Options 
menu. (If the Enable Collisions item is not checked, collisions were 
not previously active.)  (See “Enable Collisions” on page 54) 

OTHER COMMON PROBLEMS 
Here are some other things you may want to keep an eye out for. 

 Check the CD for scratches or blemishes. Even minor scratches or 
fingerprints can cause random problems that appear to be program 
bugs. 

 Make sure your hard drive has at least 30MB of space available. To 
check this: 

1. Double click on the “My Computer” icon on your desktop; 

2. Right click on your main hard drive (usually drive “C:”); 

3. When a popup menu appears, select “Properties”; 

4. In the dialog that appears, view the amount of space available on 
the drive. 

If you need additional space, try emptying the Recycle Bin. 

 Ensure that all other programs are closed prior to starting RealFlight G2 
Lite.  RealFlight G2 Lite works best when it is the only program 
running. 

 If all else fails, try rebooting your computer.  Occasionally, Windows® 
(particularly 98 and ME) may become unstable after continuous use. A 
simple reboot may clear up any difficulties. 

 Ensure that your computer is running in at least 16-bit color resolution. 
You can verify this by right clicking on the Windows® desktop and 
selecting “Properties”.  Then, click on the “Settings” tab and check the 
color palette box. 
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GGLLOOSSSSAARRYY  OOFF  TTEERRMMSS  

3D Acceleration 
3D operations require huge amounts of calculations.  Modern video cards offload 
many of these calculations to the card, rather than performing the calculations 
directly on your computer's CPU.  This speeds up the simulation and allows for 
faster frame rates, thereby increasing the realism of the simulation. 

Active View 
The Active View is the view that all commands in the View menu act on. Only one 
view at a time is active. You can make a view active by clicking on it with the 
mouse. When you want to control a view’s properties, you must first make it the 
Active View.  

AFR  
Advanced Flight Recorder. A feature of RealFlight G2 Lite that allows the pilot to 
view pre-recorded VFI maneuvers.  During the playback of maneuvers, the pilot has 
the ability to select from a number of different options such as fast forwarding, 
rewinding, looping, speeding up and slowing down the recordings.   

Aileron 
Hinged control surfaces located on the trailing edge of the wing, one on each side, 
which provide control of the airplane about the roll axis. The control direction is 
often confusing to first time modelers. For a right roll or turn, the right hand aileron 
is moved upward and the left hand aileron downward, and vice versa for a left roll or 
turn.  

Airfoil 
This is the cross-section shape of a surface (e.g., wing) that produces lift.  Airfoils 
usually have some sort of a "tear drop" shape. 

    



102    Glossary of Terms R/C Simulator RealFlight 

Auto-Play 
Automatically detects when a CD-ROM is inserted and runs the specific program on 
the CD-ROM. 

Autorotation 
A maneuver in which the heli is landed without power.  The momentum of the 
blades is enough to slow the heli prior to landing. 

 

Bilinear Textures 
Smoothes textured pixels together.  This can cause a blurry appearance but can also 
improve the overall appearance. 

Binocular View 
The Binocular View option will show a perfectly zoomed aircraft.  You will see the 
aircraft as if you were looking through a pair of binoculars.  In Binocular View, the 
background of the viewport box becomes transparent.   This is a visual indicator so 
that you are aware that this viewport is using “binocular vision”. 

Binocular View is a great way to see the control surfaces on an aircraft that is too far 
away to see in the Main View.  Although not realistic, it does help to see the control 
input.   

CG 
CG is the abbreviation for the phrase Center Of Gravity.  This is the point at which 
the airplane balances fore to aft, and side-to-side. The location of this point is crucial 
to how the airplane reacts in the air. A tail-heavy plane will be very snappy, but 
generally unstable and susceptible to more frequent stalls. Conversely, a nose-heavy 
airplane will tend to track better and be less sensitive to control inputs, but will 
generally drop its nose when the throttle is reduced to idle. This makes the plane 
more difficult to land, since it takes more effort to hold the nose up. A nose heavy 
airplane will have to come in faster to land safely.  

Collective 
A mechanism on a helicopter that changes the pitch of the main blades, thereby 
allowing the helicopter to ascend or descend accordingly.  This is the control that 
adjusts the pitch of the rotor blades. 

Collision Detection 
RealFlight G2 Lite allows the pilot to activate Collision Detection for all of the 
objects.  If activated, collision detection senses when an aircraft “bumps” into an 
object, and causes a crash.  
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Coning 
When a helicopter hovers, the blades form a slight "cone" when viewed from the 
side.  The Coning effect is caused by the balance between lift and centrifugal forces 
on the blades. 

Control Panel 
The RealFlight G2 Lite Control Panel is useful for many aspects of the G2 program.  
For details on the purpose and functionality of the Control Panel, See “Appendix B. 
RealFlight G2 Lite Control Panel” on page 83. 

Control Surface 
Generally defined as the portion of the wing that moves.  This is usually the ailerons, 
elevator, rudder, flaps or spoilers. 

Controller 
A device used to control an aircraft in RealFlight G2 Lite. Currently, all new 
versions of RealFlight G2 Lite ship with Great Planes’s USB InterLink controller by 
Futaba. This device can either be used as a standalone controller, or as an interface to 
use your own R/C transmitter to control RealFlight G2 Lite. Previous versions of 
RealFlight G2 Lite shipped with either a Futaba® game port controller, or a 
Transmitter Adapter Interface. For information on the latter two controllers, please 
see the manuals that came on the program CD with those versions of RealFlight G2 
Lite. 

Cyclic 
Refers to the changing of a main rotor blade's pitch as the rotor head rotates.  Pitch is 
added while the blade is pointing in one direction (e.g. while the blade is over the 
canopy), and removed while the blade is pointing the the opposite direction (e.g. 
while the blade is over the tail boom).  This causes the helicopter to pitch and roll. 

 

Dihedral 
The V-shaped bend in the wing. Typically, more Dihedral causes more aerodynamic 
stability in an airplane, and causes the rudder to control both the roll and yaw axis. 
This is why some trainers and sailplanes require only 3 channels of radio control 
(i.e., have no ailerons).   

Direct3D Technology 
Used to render the 3D image when you have an accelerated graphics card.  It works 
best on faster computers. 

DirectX 
A technology created by Microsoft that controls graphics and sound operations. 
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Dithering 
Blends the pixels together to produce a smoother image.  This can also simulate 
colors that may not be available to you. 

Down Thrust 
This is the downward angle of the engine in relationship to the centerline of the 
airplane. Down Thrust helps overcome the normal climbing tendency of flat bottom 
wings. 

Driver 
A software program that controls a card (e.g., video or sound card) in your computer. 
The card’s manufacturer usually provides its Driver as well. Manufacturers 
frequently update their Drivers to fix bugs, or make their cards compatible with new 
software and hardware. You can often find an updated driver for your video or sound 
card by visiting the web site of the card’s manufacturer, and following links to 
“Drivers,” “Support,” “Downloads”, or “Upgrades.” 

Elevator 
Hinged control surface located at the trailing edge of the horizontal stabilizer, which 
provides control of the airplane about the pitch axis and causes the airplane to climb 
or dive. The correct direction of control is to pull the transmitter Elevator control 
stick back, toward the bottom of the transmitter, to move the Elevator upward, which 
causes the airplane to climb, and vice versa to dive. 

 

Exponential 
A feature commonly found on computer radios that desensitizes the servo when the 
sticks are close to the neutral position.  The further the stick movement, the faster the 
controls.   

Flap 
For Airplanes: Hinged control surface located at the trailing edge of the wing inboard 
of the ailerons. The Flaps are lowered to produce more aerodynamic lift from the 
wing, allowing a slower takeoff and landing speed. Flaps are often found on scale 
models, but usually not on basic trainers. 

For Helicopters: Flapping is an up-and-down motion of the main rotor blade's tip.  
With a "dual-damped" head (as used in the Kyosho Concept helicopters, for 
example) both blades are able to Flap independently.  With "solid axle" heads (as 
used in the Hirobo Shuttle helicopters, among others), moving one blade up causes 
the other to move down.   

Flapping Head 
This describes a type of rotor head in which the two blades are not connected 
directly.  Each blade is independent of the other, usually resulting in a helicopter 
with smoother performance. 
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Flight Playback Gadget 
A gadget that lets you control playback of flight recordings using mouse actions. 

Flybar Paddles 
These are the short blades on the end of the flybar.  Available in a variety of weights 
and airfoils, these paddles assist the main blades. 

Frame Rate 
Frame Rate is the number of times per second that RealFlight G2 Lite creates a 
different picture to display on your monitor. Frame rate is determined by the speed 
of your CPU and graphics card, and how many RealFlight G2 Lite options you turn 
on. This is not the same as refresh rate, which is the number of times per second that 
your monitor retraces an image on its screen. 

Fuselage 
This is the main part of the airplane that holds the wings and engine.  Often thought 
of as the “body” of the airplane.  This term is also used to refer to a “body” that 
might be used on helicopters. 

Futaba 
Maker of quality R/C products, including the USB InterLink controller that is 
shipped with RealFlight G2 Lite. 

Gadget 
An onscreen display that shows you continuously updated information about your 
aircraft, or lets you control RealFlight G2 Lite features using mouse clicks. 

Governor 
This is a device that is used to maintain a constant RPM (head speed).  Generally 
used in helicopters rather than airplanes. 

Group 
A collection of scenery objects or foliage objects in your airport.  

Gyro 
A device, most commonly used in helicopters, that aids in controlling the yawing 
action of the helicopter by automatically adjusting the deflection of the tail rotor 
blades. 

HAL Device 
A hardware-accelerated 3D video card driver.  “HAL” is an abbreviation for the 
phrase “Hardware Abstraction Layer” that uses software drivers to communicate 
between RealFlight G2 Lite’s software and the hardware of the PC.  
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Hot Pluggable/Hot Swappable 
A device is said to be Hot Pluggable or Hot Swappable when you can safely connect 
or disconnect it without turning off your computer or rebooting.  

 

Hub 
The centralized mechanical device used to attach the main rotor blades and paddles. 

Interface Mode 
With RealFlight G2 Lite set to Interface Mode, you are using the InterLink controller 
as an interface to your own R/C radio. In Interface Mode your own radio controls 
RealFlight G2 Lite.  Conversely, in Joystick Mode RealFlight G2 Lite is controlled 
by the InterLink controller used as a mockup of a R/C transmitter.  

Interface Wizard 
When you use your own transmitter to control RealFlight G2 Lite, you must tell 
RealFlight G2 Lite which channels your transmitter uses for various control 
functions. The Interface Wizard is a sequence of dialogs that guides you through this 
process. 

InterLink controller 
Great Planes’s USB InterLink controller by Futaba is a USB device shipped with all 
new versions of RealFlight G2 Lite. The InterLink controller can either be used as a 
standalone “mockup” R/C controller, or as an interface for using your own R/C 
transmitter to control RealFlight G2 Lite. 

IP Address 
Whenever your computer is connected to the Internet, it has an IP address. This 
number is a string of digits and periods, and looks something like “123.43.6.78”. The 
IP address is like an Internet “zip code” that tells other computers where to look for 
your computer. Depending on your Internet connection, your IP address may always 
be the same, or may change each time you connect to the Internet. 

Joystick 
A device that connects to your computer, and is used to control the simulated 
aircraft.  The InterLink controller that comes with RealFlight G2 Lite is considered a 
Joystick. 

Joystick Mode 
With RealFlight G2 Lite set to this mode, RealFlight G2 Lite is controlled by the 
InterLink controller used as a mockup of a R/C transmitter. Conversely, Interface 
Mode means that you are using the InterLink controller as an interface to your own 
R/C radio. In interface mode your own radio controls RealFlight G2 Lite.   
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Low Rates 
A switch on the radio that causes the servos move to much smaller extremes, thus 
making the model respond more slowly. 

NavGuides 
A gadget that displays basic, continuously updated, information about your aircraft. 

Photofield 
A technology that creates a flying field by using a panoramic photograph as a 
background for a flat terrain. RealFlight G2 Lite offers you a choice of two display 
styles for airports: Photofield or 3D Terrains. 3D Terrains are more realistic, but 
Photofield may render more quickly if you have an older, slower computer or 
graphics card. 

Pirouette 
The yawing action of a helicopter that looks much like an ice skater.  One Pirouette 
is equal to one 360-degree rotation. 

Pitch Axis 
The airplane axis controlled by the elevator. Pitch is illustrated by holding the 
airplane at each wingtip. Raising or lowering the nose is the pitch movement. This is 
how the climb or dive is controlled. 

Propeller 
Props are generally designated by two numbers (for instance, “10 – 6”). The first 
number is the prop's length (10" in the example). The second number is the pitch or 
angle of the blades. (In the example, “6” represents the distance the Propeller will 
move forward in one revolution, in this case 6".) 

RAM 
Random Access Memory 

RAMP 
A software-only rendering technology that is usually faster than RGB.  Please note: 
although it renders faster, it does so at the expense of quality. 

RealFlight G2 Lite 
This is the next generation R/C Flight Simulator produced by Great Planes. 

RealPhysics 
This is RealFlight’s exclusive physics modeling technology. RealPhysics 
authentically replicates the actual physics of model aircraft by calculating hundreds 
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of thousands of floating point operations each second while delivering sizzling real 
time performance.   

Refresh Rate 
The number of times per second that your monitor retraces an image on its screen. 
This is different from the Frame Rate. 

Resolution 
When used in the context of screen Resolution, this term describes the picture quality 
of the screen.  Lower Resolutions will produce an image that is not as sharp as higher 
Resolutions. 

Roll Axis 
The airplane axis controlled by the ailerons. Roll is illustrated by holding the 
airplane by the nose and tail. Dropping either wingtip is the roll movement. Roll is 
used to bank or turn the airplane. In most airplanes, the ailerons control roll. 
However, when the main wing has dihedral, the plane can be banked using the 
rudder only. Consequently, many planes with wing dihedral do not have ailerons, 
and the rudder controls both roll and yaw. This is one reason why most trainer 
aircraft have a large amount of dihedral—a plane with large dihedral can be 
controlled using fewer input channels. 

Rudder 
Hinged control surface located at the trailing edge of the vertical stabilizer, which 
provides control of the airplane about the Yaw axis (causes the airplane to Yaw left 
or right). Left Rudder movement causes the airplane to Yaw left, and right Rudder 
movement causes it to Yaw right.  

Servo 
The electromechanical device that moves the control surfaces or throttle of the 
airplane according to commands from the receiver. This device does the physical 
work inside the aircraft.  

Sound Card  
A card inside your computer that controls audio (what you hear over your computer 
speakers). Most sound cards plug into your computer’s motherboard. You can 
upgrade your sound card (or the software driver that controls it) without getting a 
new computer. 

Specular Highlights 
A graphics rendering technique that makes surfaces (e.g., MonoKote™) appear 
reflective, or “shiny”, in direct light (e.g., sunlight). 
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Stall 
This is what happens when an airplane’s angle of attack is too great to generate lift, 
regardless of airspeed.  During a Stall, the plane will dive and rapidly lose altitude. 
Every airfoil has an angle of attack at which it generates maximum lift.  The airfoil 
will Stall beyond this angle. 

Swash Plate 
The mechanism in a helicopter rotor that turns non-rotating control movements into 
rotating control movements. 

Throttle Hold 
This is used to keep the throttle at a set position, yet allows input to the collective of 
the helicopter.  Generally it is used to practice autorotation. 

Tooltip 
A yellow popup window that appears when you hold the mouse cursor over a 
RealFlight G2 Lite menu item or dialog item. The text in the Tooltip window 
describes the item’s function. 

Trees 
Some elements of a RealFlight G2 Lite landscape are inserted and removed using the 
Tree editor page of the Advanced Terrain Editor. These include trees, bushes, people 
and animals.   

USB 
USB, or Universal Serial Bus, is a connection protocol for computer peripheral 
devices (like Great Planes’s USB InterLink controller by Futaba®). USB technology 
allows you to connect multiple devices to your computer, and supports high data 
transfer rates and hot swappable. USB devices have a special connector that only fits 
into a USB port. Most modern personal computers have USB ports, which are usually 
clearly labeled.   

Video Card 
A card inside your computer that produces the images on your video monitor. Most 
modern 3D video cards have accelerated 3D operations—that is, they perform 
numerical calculations for rendering a 3D scene, to free up your computer’s CPU to 
perform other tasks. The video card plugs into your computer’s motherboard.  You 
can upgrade your video card (or the software driver that controls it) without 
replacing your computer. 

Viewport 
A picture-in-picture display inset within the RealFlight main display.   
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Virtual Flight Instructor 
This RealFlight G2 Lite feature lets you choose from a variety of prerecorded 
maneuver training lessons.  The maneuver is then demonstrated on screen, along 
with the instructor’s voice and control stick movements. You can speed up, slow 
down and even loop the maneuver playback for training purposes.   

VirtualRevolution 
This is the exclusive sound technology used by RealFlight G2 Lite.  As with the 
original RealFlight programs, the sounds are Doppler-correct, however, if the user’s 
sound card supports it, surround sound is also available. 

Washout  
An intentional twist in the wing, causing the wing tips to have a lower angle of attack 
than the wing root. In other words, the trailing edge is higher than the leading edge at 
the wing tips. Washout helps prevent tip stalls.   

Wing Loading 
This is the amount of weight per square foot that has to be overcome to provide lift. 
It is normally expressed in ounces per square foot. This specification can be easily 
calculated as follows: If you know the square inches of the wing, simply divide by 
144 to obtain square feet. Divide the total weight (in ounces) of the airplane by the 
wing area (in square feet). This information is valuable when deciding on which 
airplane to build next. Planes with high wing loading numbers must fly faster to stay 
in the air. These are generally "performance" airplanes. Conversely, planes with 
lower numbers do not need as much air flowing around the wing to keep it flying. 
Gliders and trainer airplanes fall into this category because slow, efficient flight is 
desirable. 

Yaw Axis 
The airplane axis controlled by the rudder. Yaw is illustrated by hanging the airplane 
level by a wire located at the center of gravity. Left or right movement of the nose is 
the Yaw movement. 
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